3410 Series Gas Ultrasonic Flow Meters

Models 3414, 3412 and 3411
## Safety and approval information

This Rosemount product complies with all applicable European directives when properly installed in accordance with the instructions in this manual. Refer to the EU declaration of conformity for directives that apply to this product. The EU declaration of conformity, with all applicable European directives, and the complete ATEX Installation Drawings and Instructions are available on the internet at [www.emerson.com](http://www.emerson.com) or through your local Emerson support center.

Information affixed to equipment that complies with the Pressure Equipment Directive, can be found on the internet at [www.emerson.com](http://www.emerson.com).

For hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

## Other information

Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the user manual. Product data sheets and manuals are available from the Emerson website at [www.emerson.com](http://www.emerson.com).

## Return policy

Follow Emerson procedures when returning equipment. These procedures ensure legal compliance with government transportation agencies and help provide a safe working environment for Emerson employees. Emerson will not accept your returned equipment if you fail to follow Emerson procedures. Return procedures and forms are available on our web support site at [www.emerson.com](http://www.emerson.com), or by phoning the Emerson Customer Service department.

### Emerson Flow customer service

**Email:**
- Worldwide: flow.support@emerson.com
- Asia-Pacific: APflow.support@emerson.com

**Telephone:**

<table>
<thead>
<tr>
<th>North and South America</th>
<th>Europe and Middle East</th>
<th>Asia Pacific</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>800 522 6277</td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>+1 303 527 5200</td>
<td></td>
</tr>
<tr>
<td>Mexico</td>
<td>+41 (0) 41 7686 111</td>
<td></td>
</tr>
<tr>
<td>Argentina</td>
<td>+54 11 4837 7000</td>
<td></td>
</tr>
<tr>
<td>Brazil</td>
<td>+55 15 3413 8000</td>
<td></td>
</tr>
<tr>
<td>Central &amp; Eastern</td>
<td>+41 (0) 41 7686 111</td>
<td></td>
</tr>
<tr>
<td>Russia/CIS</td>
<td>+7 495 981 9811</td>
<td></td>
</tr>
<tr>
<td>Egypt</td>
<td>0800 000 0015</td>
<td></td>
</tr>
<tr>
<td>Oman</td>
<td>800 70101</td>
<td></td>
</tr>
<tr>
<td>Qatar</td>
<td>431 0044</td>
<td></td>
</tr>
<tr>
<td>Kuwait</td>
<td>663 299 01</td>
<td></td>
</tr>
<tr>
<td>South Africa</td>
<td>800 991 390</td>
<td></td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>800 844 9564</td>
<td></td>
</tr>
<tr>
<td>UAE</td>
<td>800 0444 0684</td>
<td></td>
</tr>
</tbody>
</table>
# Contents

## Chapter 1  
**Introduction**

- 1.1 Typical applications of this product............................................... 5  
- 1.2 Features and benefits of the 3411, 3412 and 3414 models meter....................... 5  
- 1.3 Acronyms, abbreviations and definitions....................................................... 6  
- 1.4 MeterLink software.......................................................................................... 9  
- 1.5 Design of Rosemount™ 3410 series meter................................................... 9  
- 1.6 Meter specifications for 3411, 3412 and 3414 models.................................... 13  
- 1.7 Preinstallation considerations........................................................................... 20  
- 1.8 Safety considerations........................................................................................ 21  
- 1.9 Certifications and approvals for the Rosemount™ 3410 series....................... 22  
- 1.10 FCC compliance............................................................................................... 22  
- 1.11 References........................................................................................................ 23

## Chapter 2  
**Mechanical installation**

- 2.1 Meter piping, lifting and mounting................................................................. 25  
- 2.2 Meter components............................................................................................. 27  
- 2.3 Pipe recommendations...................................................................................... 32  
- 2.4 Pre-installation inspection................................................................................ 34  
- 2.5 Mounting requirements in heated or cooled pipelines..................................... 43

## Chapter 3  
**Electrical installation**

- 3.1 Cable length TTL mode...................................................................................... 45  
- 3.2 Cable length Open Collector mode.................................................................... 45  
- 3.3 Grounding meter electronics housing............................................................... 46  
- 3.4 Conduit seals...................................................................................................... 47  
- 3.5 Wiring and inputs/outputs.................................................................................. 54  
- 3.6 Security seal installation..................................................................................... 74  
- 3.7 Sealing the unit.................................................................................................. 79

## Chapter 4  
**Configuration**

- 4.1 Set up the MeterLink™ .................................................................................... 81  
- 4.2 Field Setup Wizard.......................................................................................... 81  
- 4.3 Using AMS Device Manager to configure the meter........................................ 88  
- 4.4 Using a Field Communicator to configure the meter........................................ 104  
- 4.5 Security seals for the meter (optional).............................................................. 106  
- 4.6 Configure users and network security............................................................. 106

## Appendix A  
**Engineering drawings**

- A.1 3410 Series engineering drawings.................................................................. 107

## Appendix B  
**Open source licenses**

- 109
B.1 List of source codes for executable files................................................................. 109
B.2 GNU General Public License....................................................................................... 109
B.3 GNU Lesser General Public License......................................................................... 115
B.4 BSD Open Source License.......................................................................................... 117
B.5 M.I.T License............................................................................................................... 118
B.6 Zlib License................................................................................................................ 119
1 Introduction

1.1 Typical applications of this product
Rosemount™ 3410 Series Ultrasonic Gas Flow Meters have various configurations that meet a broad range of customer requirements. Each meter comes fully assembled from Rosemount. The technology can be applied to custody transfer, allocation measurement, and check metering applications such as:

• Custody transfer
• Power plants
• Large industrial users
• Production
• Underground storage sites
• Offshore
• Allocation measurement

1.2 Features and benefits of the 3411, 3412 and 3414 models meter

• Secondary backup measurement
• Configurable read-only serial ports
• GERG-2008 and Detail AGA Methods
• Custody meter verification
• Proven long term stability
• Field proven reliability
• No line obstruction
• No pressure loss
• Low maintenance
• Bi-directional measurement
• Extensive self-diagnostics
• Immediate alarm reporting
• Continuous Flow Analysis
  — Abnormal profile
  — Blockage
  — Internal bore buildup
  — Liquids present in the gas meter
— Reverse Flow
— Speed of Sound comparison error

- Auto-detected ASCII/RTU Modbus communications protocol
- Low power consumption
- Sophisticated noise reduction
- Internet-ready communications
- Ethernet access
- On-board LED status indicators
- Analog pressure and temperature inputs
- Communication via Emerson’s AMS™ Device Manager and Field Communicator
- API Chapter 21 compliant event and data logging (gas meters)
- MeterLink™ (a Windows®-based interface software)
- Local Display (optional)
- Smart Meter Verification (4-Path and 8-Path meters)

For other features and benefits refer to the ultrasonic flow meter product datasheets: www.emerson.com.

### 1.3 Acronyms, abbreviations and definitions

<table>
<thead>
<tr>
<th>Acronym or abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>°</td>
<td>degree (angle)</td>
</tr>
<tr>
<td>°C</td>
<td>degrees celsius (temperature unit)</td>
</tr>
<tr>
<td>°F</td>
<td>degrees fahrenheit (temperature unit)</td>
</tr>
<tr>
<td>ADC</td>
<td>analog-to-digital converter</td>
</tr>
<tr>
<td>AI</td>
<td>Analog Input</td>
</tr>
<tr>
<td>AMS® Device Manager</td>
<td>Asset Management Software - Device Manager</td>
</tr>
<tr>
<td>AO</td>
<td>Analog Output</td>
</tr>
<tr>
<td>ASCII MODBUS</td>
<td>A Modbus protocol message framing format in which ASCII characters are used to delineate the beginning and end of the frame. ASCII stands for American Standard Code for Information Interchange.</td>
</tr>
<tr>
<td>boolean</td>
<td>A type of data point that can only take on values of TRUE or FALSE (generally TRUE is represented by a value of 1, FALSE is represented by a value of 0).</td>
</tr>
<tr>
<td>bps</td>
<td>Bits Per Second (baud rate)</td>
</tr>
<tr>
<td>cPoise</td>
<td>centipoise (viscosity unit)</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>Acronym or abbreviation</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>C T S</td>
<td>Clear-to-Send; the RS-232C hand shaking signal input to a transmitter indicating that it is okay to transmit data - i.e., the corresponding receiver is ready to receive data. Generally, the Request-to-Send (RTS) output from a receiver is input to the Clear-to-Send (CTS) input of a transmitter.</td>
</tr>
<tr>
<td>DAC</td>
<td>Digital-to-Analog Converter</td>
</tr>
<tr>
<td>MeterLink™</td>
<td>Ultrasonic Meter interface software</td>
</tr>
<tr>
<td>DI</td>
<td>Digital Input</td>
</tr>
<tr>
<td>DO</td>
<td>Digital Output</td>
</tr>
<tr>
<td>DHCP</td>
<td>Dynamic Host Configuration Protocol</td>
</tr>
<tr>
<td>dm</td>
<td>decimeter ($10^{-1}$ meters, length unit)</td>
</tr>
<tr>
<td>ECC</td>
<td>Error Correction Code</td>
</tr>
<tr>
<td>EEPROM</td>
<td>Electrically-Erasable, Programmable Read-Only Memory</td>
</tr>
<tr>
<td>Flash</td>
<td>non-volatile, programmable read-only memory</td>
</tr>
<tr>
<td>FODO</td>
<td>output that is user configurable as either a Frequency or Digital Output</td>
</tr>
<tr>
<td>HART® Communication Protocol</td>
<td>Highway Addressable Remote Transducer communications protocol</td>
</tr>
<tr>
<td>hr</td>
<td>hour (time unit)</td>
</tr>
<tr>
<td>Hz</td>
<td>Hertz (cycles per second, frequency unit)</td>
</tr>
<tr>
<td>I/O</td>
<td>Input/Output</td>
</tr>
<tr>
<td>IS</td>
<td>Intrinsically Safe</td>
</tr>
<tr>
<td>K</td>
<td>Kelvin (temperature unit)</td>
</tr>
<tr>
<td>kHz</td>
<td>kilohertz (103 cycles per second, frequency unit)</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LED</td>
<td>Light-emitting Diode</td>
</tr>
<tr>
<td>m</td>
<td>meter (length unit)</td>
</tr>
<tr>
<td>m³/d</td>
<td>cubic meters per day (volumetric flow rate)</td>
</tr>
<tr>
<td>m³/h</td>
<td>cubic meters per hour (volumetric flow rate)</td>
</tr>
<tr>
<td>m³/s</td>
<td>cubic meters per second (volumetric flow rate)</td>
</tr>
<tr>
<td>mA</td>
<td>milliamp (current unit)</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Media Access Control (Ethernet Hardware Address - EHA)</td>
</tr>
<tr>
<td>microinch (m inch)</td>
<td>microinch ($10^{-6}$ in)</td>
</tr>
<tr>
<td>micron</td>
<td>micrometer ($10^{-6}$ m)</td>
</tr>
<tr>
<td>MMU</td>
<td>Memory Management Unit</td>
</tr>
<tr>
<td>Acronym or abbreviation</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>MPa</td>
<td>megapascal (equivalent to $10^6$ Pascal) (pressure unit)</td>
</tr>
<tr>
<td>N/A</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Nm$^3$/h</td>
<td>normal cubic meters per hour</td>
</tr>
<tr>
<td>NVRAM</td>
<td>Non-Volatile Random Access Memory</td>
</tr>
<tr>
<td>Pa</td>
<td>Pascal, equivalent to 1 newton per square meter (pressure unit)</td>
</tr>
<tr>
<td>Pa × s</td>
<td>Pascal Second (viscosity unit)</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PFC</td>
<td>Peripheral Field Connection (Board)</td>
</tr>
<tr>
<td>P/N</td>
<td>Part Number</td>
</tr>
<tr>
<td>PS</td>
<td>Power Supply (board)</td>
</tr>
<tr>
<td>psi</td>
<td>pounds per square inch (pressure unit)</td>
</tr>
<tr>
<td>psia</td>
<td>pounds per square inch absolute (pressure unit)</td>
</tr>
<tr>
<td>psig</td>
<td>pounds per square inch gage (pressure unit)</td>
</tr>
<tr>
<td>R</td>
<td>Radius of meter</td>
</tr>
<tr>
<td>rad</td>
<td>radian (angle)</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RTS</td>
<td>Request-to-Send; the RS-232C hand shaking signal output by a receiver when it is ready to receive data</td>
</tr>
<tr>
<td>RTU MODBUS</td>
<td>A Modbus protocol framing format in which elapsed time between received characters is used to separate messages. RTU stands for Remote Terminal Unit.</td>
</tr>
<tr>
<td>s</td>
<td>second (time unit, metric)</td>
</tr>
<tr>
<td>SDRAM</td>
<td>Synchronous Dynamic Random Access Memory</td>
</tr>
<tr>
<td>sec</td>
<td>second (time unit, U.S. Customary)</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>time_t</td>
<td>seconds since Epoch (00:00:00 UTC Jan. 1, 1970) (time unit)</td>
</tr>
<tr>
<td>UDP</td>
<td>User Datagram Protocol</td>
</tr>
<tr>
<td>U.L.</td>
<td>Underwriters Laboratories, Inc. - product safety test in gand certification organization</td>
</tr>
<tr>
<td>V</td>
<td>Volts (electric potential unit)</td>
</tr>
<tr>
<td>W</td>
<td>Watts (power unit)</td>
</tr>
</tbody>
</table>
1.4 **MeterLink software**

MeterLink software has robust features for setting communications parameters, configuring your meter, collecting logs and reports and monitoring the meter health and alarm statuses. MeterLink may be downloaded at no charge from: [www.emerson.com/meterlink](http://www.emerson.com/meterlink).

**Figure 1-1: MeterLink download and registration**


1.5 **Design of Rosemount™ 3410 series meter**

Rosemount 3410 Series Gas Ultrasonic Flow Meters are designed to accurately measure products in applications where reliable performance is critical, by measuring the difference in signal transit time with and against the flow across one or more measurement path(s). A signal transmitted in the flow direction travels faster than one transmitted against the flow direction. Each measurement path is defined by a transducer pair in which each transducer alternately acts as transmitter and receiver. The meter uses transit time measurements and transducer location information to calculate the mean velocity.

Computer simulations of various velocity profiles demonstrate that multiple measurement paths provide an optimum solution for measuring asymmetric flow.

*Rosemount 3414* Gas Ultrasonic Flow meters utilize four cross-bore, parallel-plane measurement paths that offer a high degree of accuracy, repeatability, bi-directional measurement and superior low-flow capabilities without the compromises associated with conventional technologies. These features make the Rosemount 3414 the best choice for custody transfer applications.
Figure 1-2: Rosemount 3414 Gas Ultrasonic Flow Meter design

A. Transmitter electronics enclosure (explosion-proof) Optional - Local Display with glass endcap. (See Figure 1-5.)
B. Base electronics enclosure (intrinsically safe)
C. Meter body with transducer assemblies (T-11, T-12, T-21, T-22 or T-200) (intrinsically safe)

*Rosemount 3412* Gas Ultrasonic Flow meters utilize two-path in-line (four transducers) measurement paths and are designed to measure the difference in signal transit time with and against the flow across one or more measurement path(s). The two paths are configured at right angles to one another in a “bullseye” arrangement.
Figure 1-3: Rosemount 3412 Gas Ultrasonic Flow Meter design

A. Transmitter electronics enclosure (explosion-proof) Optional - Local Display with glass endcap. (See Figure 1-5.)

B. Base electronics enclosure (intrinsically safe)

C. Meter body with transducer assemblies (T-11, T-12, T-21 and T-22) (intrinsically safe)

*Rosemount 3411* Gas Ultrasonic Flow meters are single-path (two transducer) Gas Ultrasonic Flow Meter and is referred to as a bounce-path (as the signal is bounced off the meter body) or a centerline path (as it goes through the centerline of the meter body) meter. The bounce-path method simplifies construction of the meter and makes the meter less susceptible to interference from pipeline liquids.
The Rosemount Gas Ultrasonic Flow Meter design is available with an optional glass endcap and a local display.

All Rosemount ultrasonic flow meter's U.L. safety listing is accomplished through the combination of an explosion-proof transmitter electronics enclosure that houses the CPU module, Power Supply board, I.S. Barrier board, Backplane board and optional LCD Display board.

**Note**
The optional LCD Display requires firmware v1.04 or later and Uboot version, January 31, 2013.
The Base Electronics Enclosure that houses the Acquisition Module. Intrinsically safe transducers and cable assemblies are designed for Class 1, Division 1, Groups C and D areas without need of further protection when installed in accordance with the field wiring diagram (refer to Rosemount drawing DMC-005324 in Engineering drawings).

1.6 Meter specifications for 3411, 3412 and 3414 models

⚠ WARNING

CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer holder.
Attempting to do so could release pressurized gases, resulting in serious injury or equipment damage.

⚠ WARNING

CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the T-200 transducer assembly. If gas or fluid begins to leak from the T-200 transducer stalk assembly, stop immediately and reinstall T-200 stalk assembly. Failure to comply could cause serious injury or equipment damage.
A. Transducer holder

⚠ CAUTION

ESCAPING GASES OR FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Rosemount™ components/seals and materials compatible with the chemical properties of gas flow measurement.
Failure to select the suitable meter component/seals may cause escaping gases or liquids, resulting in injury or equipment damage.

Consult your Rosemount™ Sales and Service representative to ensure you purchase the correct components and seals for your application. Specifications for Rosemount Gas Ultrasonic Flow Meters models 3411, 3412 and 3414 are below:
Table 1-1: Rosemount™ models 3411, 3412 and 3414 meter specifications (part 1)

<table>
<thead>
<tr>
<th>Rosemount™ 3411, 3412 and 3414 meter specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Meter type</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Ultrasonic type</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Enclosure materials</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Meter performance**

| Linearity                                           | • Model 3414 Four-path meter chordal design              |
|                                                     | — ± 0.3% of measured value over a 100:1 turndown 3-100 ft/s; 0.3 to 30 m/s including lab uncertainty |
|                                                     | — Flow calibrated accuracy is ± 0.1% of reading relative to lab over entire flow calibration range (Qmin - Qmax) |
|                                                     | • Model(s) 3411 single-path or 3412 two-path            |
|                                                     | — Flow calibrated accuracy is ± 0.5% of reading relative to lab |
|                                                     | — Accuracy is typically ±1.5% of actual volume flow^(1) (without flow calibration) |

^(1)Does not take into consideration changes in wall roughness and installation effects.

| Repeatability                                      | ±0.05% of reading in the specified velocity range from 5% to 100% (Qmax) |
Table 1-1: Rosemount™ models 3411, 3412 and 3414 meter specifications (part 1) (continued)

<table>
<thead>
<tr>
<th>Rosemount™ 3411, 3412 and 3414 meter specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity range</td>
</tr>
<tr>
<td>• 100 ft/s (30 m/s) with over-range)</td>
</tr>
<tr>
<td>• 125 fps (38 m/s) on some line sizes</td>
</tr>
<tr>
<td>• Meter meets or exceeds AGA9 (2007) performance specifications</td>
</tr>
</tbody>
</table>

Table 1-2: Performance specifications

<table>
<thead>
<tr>
<th>Meter size</th>
<th>4” to 24”</th>
<th>30”</th>
<th>36”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qmin(ft/s)</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Qt (ft/s)</td>
<td>10</td>
<td>8.5</td>
<td>7.5</td>
</tr>
<tr>
<td>Qmax (ft/s)</td>
<td>100</td>
<td>85</td>
<td>75</td>
</tr>
</tbody>
</table>

Table 1-3: Rosemount™ models 3411, 3412 and 3414 meter specifications (part 2)

<table>
<thead>
<tr>
<th>Body and Flange Sizes and Pressure rating range</th>
<th>U.S. Customary Units - Meter sizes 4, 6, 8, 10, 12, 16, 18, 20, 24, 30, and 36 (inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• ANSI pressure classes 300, 600, 900 and 1500 (per ANSI B16.5)</td>
</tr>
<tr>
<td></td>
<td>• Carbon Steel</td>
</tr>
<tr>
<td></td>
<td>• 316 Stainless Steel</td>
</tr>
<tr>
<td>Metric Units - Meter sizes DN - 100, 150, 200, 250, 300, 400, 450, 500, 600, 700, 750, 900</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• PN 50, 100, 150, 200</td>
</tr>
<tr>
<td></td>
<td>• Carbon Steel</td>
</tr>
<tr>
<td></td>
<td>• 316 Stainless Steel</td>
</tr>
<tr>
<td>Maximum Pressures</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Dependent on operating temperature</td>
</tr>
<tr>
<td>Meter bore</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Schedule 20, 30, 40, 60, 80, 100, 120, 140, 160, STD, XS, LW</td>
</tr>
<tr>
<td>Flange types</td>
<td>ANSI classes - 300, 600, 900 and 1500 (per ANSI B16.5)</td>
</tr>
<tr>
<td>Specific Gravity</td>
<td>0.35 to 1.50</td>
</tr>
</tbody>
</table>
Table 1-3: Rosemount™ models 3411, 3412 and 3414 meter specifications (part 2) (continued)

<table>
<thead>
<tr>
<th>Accuracy Limits</th>
<th>Model 3414 accuracy limits (AGA 9 compliant) are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• ± 1% without a flow calibration (10” and</td>
</tr>
<tr>
<td></td>
<td>smaller line sizes)</td>
</tr>
<tr>
<td></td>
<td>• ± 0.7% without a flow calibration (for 12”</td>
</tr>
<tr>
<td></td>
<td>and larger line sizes)</td>
</tr>
<tr>
<td></td>
<td>• ±0.1% with a flow calibration</td>
</tr>
<tr>
<td></td>
<td>Model(s) 3411 and 3412 accuracy limits are:</td>
</tr>
<tr>
<td></td>
<td>• ± 1.5% without a flow calibration</td>
</tr>
</tbody>
</table>

Minimum operating pressure 100 psig (7 bar)

**Electronic specifications**

Power

- 10.4 VDC to 36 VDC
- 11 W power consumption (15 W maximum)

Serial cable

- Belden #9940 or equivalent (22 gauge)
  - Capacitance (pF/m) 121.397 (conductor to conductor)
  - Capacitance (pF/m) 219.827 (conductor to other conductor and shield)
  - Resistance (DC) DCR @ 20° C (recommended)

Ethernet cable

- Cat-5 Standard 100 Mbps

Frequency (see Table 1-2)

- 22 AWG wire characteristics areas follows:
  - Capacitance = 20 pF/ft or 20 nF/1000 ft (between two wires)
  - Resistance = 0.0168 Ohms/ft or 16.8 Ohms/1000 ft
  - Pull-up voltages 24 VDC
<table>
<thead>
<tr>
<th>Transducer type</th>
<th>Temperature range</th>
<th>Mount and holder type</th>
</tr>
</thead>
<tbody>
<tr>
<td>T-11</td>
<td>-20 °C to +100 °C (-4 °F to 212 °F)</td>
<td>Standard mounts/holders, NBR O-ring Inconel mounts/316L holders, NBR O-ring Inconel mounts/inconel holders/FKM O-ring</td>
</tr>
<tr>
<td>T-12</td>
<td>-20 °C to +100 °C (-4 °F to 212 °F)</td>
<td>Standard mounts/holders, NBR O-ring Inconel mounts/316L holders, NBR O-ring Inconel mounts/inconel holders/FKM O-ring</td>
</tr>
<tr>
<td>T-21(^1)</td>
<td>-20 °C to +100 °C (-4 °F to 212 °F)</td>
<td>Standard mounts/holders, NBR O-ring Inconel mounts/316L holders, NBR O-ring Inconel mounts/inconel holders/FKM O-ring</td>
</tr>
<tr>
<td>T-22(^2)</td>
<td>-50 °C to +100 °C (-58°F to 212 °F)</td>
<td>Standard mounts/holders, NBR O-ring Inconel mounts/316L holders, NBR O-ring Inconel mounts/inconel holders/FKM O-ring</td>
</tr>
<tr>
<td>T-200</td>
<td>-50 °C to +125 °C (-58°F to 257 °F)</td>
<td>Standard stalk assemblies Inconel stalk assemblies</td>
</tr>
</tbody>
</table>

\(^1\) T-21 transducers use W-01 transformers  
\(^2\) T-22 transducers use W-02 transformers

**Note**  
The process temperature must not exceed the operating temperature range of the transducers.

**Note**  
T-11 and T-21 transducers are designed for 14 inch and larger meters. T-12, T-22 and T-200 transducers are designed for 4” through 12” meters.

**Note**  
T-11 and T-21 transducers are used for all meter sizes for Models 3411 and 3412.

**Note**  
The ultrasonic transducers are not intended for use across boundary walls of different hazardous area classifications. The transmitter electronics cannot be remote mounted from Division 1 classification to a Division 2 area to meet an area classification.
### Table 1-5: Rosemount™ models 3411, 3412 and 3414 meter specifications (part 3)

<table>
<thead>
<tr>
<th><strong>Communications specifications</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connectivity protocols</strong></td>
<td>One serial RS-232/RS-485 port (115 kbps baud rate) (Modbus RTU/ASCII)</td>
</tr>
<tr>
<td></td>
<td>• (1) Serial Port A</td>
</tr>
<tr>
<td></td>
<td>• (RS-232/RS-485 Full Duplex/RS-485 Half Duplex)</td>
</tr>
<tr>
<td><strong>Device compatibility</strong></td>
<td>Rosemount Ultrasonic flow meters are compatible with nearly every commercially available flow computer. Examples: FloBoss 103, FloBoss S600 flow computer, ROC 107</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Digital, analog, and frequency inputs</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Digital Input(s) (Selectable)</strong></td>
<td>(1) Single polarity</td>
</tr>
<tr>
<td></td>
<td>• Four pulse configurations available</td>
</tr>
<tr>
<td><strong>Analog Input(s)</strong></td>
<td>(2) 4-20 mA</td>
</tr>
<tr>
<td></td>
<td>• AI-1 Temperature</td>
</tr>
<tr>
<td></td>
<td>• AI-2 Pressure</td>
</tr>
</tbody>
</table>

**Note**
The analog-to-digital conversion accuracy is within ±0.05% of full scale over the operating temperature range.

**Note**
AI-1 and AI-2 are electronically isolated and operate in sink mode. The input contains a series resistance so HART® Communicators can be connected to configure sensors.

A 24 Volt DC power output is available to provide power to the sensors.
### Table 1-5: Rosemount™ models 3411, 3412 and 3414 meter specifications (part 3) (continued)

<table>
<thead>
<tr>
<th>Frequency/Digital Output(s)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>The meter has user-configurable selections for either a frequency output or digital status (FODO) (Also see Frequency/Digital outputs).</td>
<td>Frequency/Digital Outputs</td>
</tr>
<tr>
<td>• FODO1 (eight possible output configurations)</td>
<td>• FODO1 (eight possible output configurations)</td>
</tr>
<tr>
<td>• FODO2 (eight possible output configurations)</td>
<td>• FODO2 (eight possible output configurations)</td>
</tr>
<tr>
<td>• FODO3 (eight possible output configurations)</td>
<td>• FODO3 (eight possible output configurations)</td>
</tr>
<tr>
<td>• FODO4 (eight possible output configurations)</td>
<td>• FODO4 (eight possible output configurations)</td>
</tr>
<tr>
<td>• FODO5 (eight possible output configurations)</td>
<td>• FODO5 (eight possible output configurations)</td>
</tr>
<tr>
<td>• FODO6 (eight possible output configurations)</td>
<td>• FODO6 (eight possible output configurations)</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td>Frequency or Digital Output parameter pairs (see Frequency/Digital outputs)</td>
<td>Frequency or Digital Outputs (FODO1, FODO2, FODO3, FODO4, FODO5, FODO6) source selections</td>
</tr>
<tr>
<td>• (FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B)</td>
<td>• (FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B)</td>
</tr>
<tr>
<td><strong>Mode options:</strong></td>
<td><strong>Mode options:</strong></td>
</tr>
<tr>
<td>• Open Collector (requires external excitation supply voltage and pull-up resistor)</td>
<td>• Open Collector (requires external excitation supply voltage and pull-up resistor)</td>
</tr>
<tr>
<td>• TTL (internally powered by the meter 0-5 VDC signal)</td>
<td>• TTL (internally powered by the meter 0-5 VDC signal)</td>
</tr>
<tr>
<td><strong>Channel B Phase options:</strong></td>
<td><strong>Channel B Phase options:</strong></td>
</tr>
<tr>
<td>• Lag forward, Lead reverse (Phase B lags Phase A while reporting forward flow, leads Phase A while reporting reverse flow)</td>
<td>• Lag forward, Lead reverse (Phase B lags Phase A while reporting forward flow, leads Phase A while reporting reverse flow)</td>
</tr>
<tr>
<td>• Lead forward, Lag reverse (Phase B leads Phase A while reporting forward flow, lags Phase A while reporting reverse flow)</td>
<td>• Lead forward, Lag reverse (Phase B leads Phase A while reporting forward flow, lags Phase A while reporting reverse flow)</td>
</tr>
</tbody>
</table>
Table 1-5: Rosemount™ models 3411, 3412 and 3414 meter specifications (part 3) (continued)

<table>
<thead>
<tr>
<th>Phase A and Phase B output (based on flow direction)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Reverse flow - output only reports flow in the reverse direction. For frequency outputs, Phase B of the output is 90 degrees out of phase with Phase A.</td>
</tr>
<tr>
<td>• Forward flow - output only reports flow in the forward direction. For frequency outputs, Phase B of the output is 90 degrees out of phase with Phase A.</td>
</tr>
<tr>
<td>• Absolute - output reports flow in both directions. For frequency outputs, Phase B of the output is 90 degrees out of phase with Phase A.</td>
</tr>
<tr>
<td>• Bidirectional - output reports flow on Phase A only in the forward direction and on Phase B only in the reverse direction.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum frequency for the frequency outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 1000Hz</td>
</tr>
<tr>
<td>• 5000Hz</td>
</tr>
</tbody>
</table>

Analog Output(s)

| (1) 4-20 mA independently configurable analog output (HART) |
| (1) 4-20 mA independently configurable analog output (conventional) - Type 2 CPU ONLY The analog output zero scale offset error is within ±0.1% of full scale and gain error is within ±0.2% of full scale. |

The total output drift is within ±50 ppm of full scale per °C.

1.7 Preinstallation considerations

• Pipeline equipment code compliance, ANSI, ASME, etc.
• Proper Inlet/outlet meter tube piping for reasonable stable flow to the settling chamber (first meter tube spool upstream of the meter).
• Electrical safety compliance; UL, CSA, ATEX, IECEx etc.
• Civil and structural good practices compliance
• Contractual agreements or governmental compliance (or both)
• In-situ performance test procedures
• Field tested meter health check and flow dynamics diagnostics
1.8 Safety considerations

The Rosemount™ 3410 Series Gas Ultrasonic Flow Meter is suitable for use in U.L. Class 1, Division 1, Group C and D hazardous locations.

NOTICE

An “X” signifies the user should contact Emeron for information on the dimensions of the flameproof joints.

Refer to the 3410 Series Systems Wiring Diagram, Sheet 3 (DMC-005324) for the certification tag (see 3410 Series engineering drawings).

Rosemount 3410 Series Gas Ultrasonic Meters are INMETRO certified. Refer to the 3410 Series Gas Ultrasonic Flow Meter Tag, INMETRO Certification drawing DMC-006224.

Certificate number: UL-BR 16.0144X

Marking: Ex db ia IIB T4...T3 Gb

Electrical parameters: Refer to Meter specifications for 3411, 3412 and 3414 models, 3410 Series engineering drawings.

Special conditions for safe use

- Explosion proof joint dimensions are compliant with the Brazilian Association of technical standard: ABNT NBR IEC 60079-1, Table 3.
- The enclosure for the explosion proof transmitter and intrinsically safe barrier must be remote mounted (refer to Table 1-3) if the operating temperature exceeds 140 °F (60 °C) (refer to Table 1-3).
- Cable length (refer to Table 1-3).

⚠️ WARNING

EXPLOSION OR FIRE HAZARD
Conduit runs must have a sealing fitting within 18 inches (457 mm) of the enclosure to reduce the risk of an explosion or a fire.

- During operation, keep covers tight.
- During equipment maintenance, disconnect power before opening transmitter or base electronics. Clean cover joints before replacing.
- DO NOT substitute meter components. Component substituting may compromise the intrinsic safety.

Failure to comply could result in severe injury to personnel or cause damage to the equipment.
1.9 Certifications and approvals for the Rosemount™ 3410 series

Rosemount™ 3410 Series Gas Ultrasonic Flow Meters have electrical, metrology, intrinsic safety and Pressure Equipment Directive certifications and approvals by the agencies listed below. Refer to the nameplate tag on the meter body, the wiring diagram (DMC-005324) in 3410 Series engineering drawings and observe all safety precautions. Rosemount 3410 Series Gas Ultrasonic Flow Meters operate within the pressure and temperature range of the device (also see Design of Rosemount™ 3410 series meter). Rosemount 3410 Series Gas Ultrasonic Flow Meters are approved to the ATEX Directive 94/9/EC.

Standards
• US
• Canada
• Europe
  — Explosive Atmospheres (ATEX)
  — International Electrotechnical Commission (IECEx)
  — Pressure Equipment Directive (PED via BSI)
  — Electromagnetic Compatibility (EMC)
  — International Organization of Legal Metrology (OIML)

Approval agencies
• UL
• c-UL
• DEMKO
• INMETRO
• NEPSI
• GOSTR

Important
Please consult Emerson Flow services for Rosemount products for the complete metrology approvals list.

1.10 FCC compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**NOTICE**

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

### 1.11 References


4. Speed of Sound in Natural Gas and Other Related Hydrocarbon Gasses, Report 10, First Edition, May 2003 (also referred to as AGA10)


2 Mechanical installation

2.1 Meter piping, lifting and mounting

Refer to the following sections for piping recommendations, lifting with hoist rings and slings, mounting in heated or cooled pipelines and safety warnings and precautions.

⚠️ CAUTION

SURFACE TEMPERATURE HAZARD
The meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.

⚠️ WARNING

CUTTING HAZARD
Sharp edges may be present on the transducer retaining ring.
Wear appropriate eye protection equipment when removing or installing the transducer retaining ring.
Failure to comply could cause serious injury.

⚠️ CAUTION

TRANSPORTATION HAZARD
When moving the meter, do not insert the forks of a forklift into the bore.
Inserting the forks may cause the meter to become unstable, resulting in injury or damage to the bore and sealing face.

⚠️ CAUTION

TRIPPING HAZARD
Clear all obstacles or obstructions from the work area when transporting, installing or removing the meter.
Failure to clear the work area may cause injury to personnel.
WARNING
CRUSHING HAZARD
Do not remove flange stabilizers.
Attempting to do so could allow the meter to roll, resulting in serious injury or equipment damage.

A. Flange stabilizers

WARNING
CRUSHING HAZARD
Before installation, do not rest the meter on a slope of greater than 10 degrees. Also ensure the surface is solid so that the flange stabilizers do not sink into the surface.
Failure to comply could allow the meter to roll, resulting in serious injury or equipment damage.

CAUTION
ESCAPING GASES OR FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Rosemount™ components/seals and materials compatible with the chemical properties of gas flow measurement.
Failure to select the suitable meter component/seals may cause escaping gases or liquids, resulting in injury or equipment damage.
CAUTION

ESCAPING GASES OR FLUIDS HAZARD

Process Seal Materials Single Seal Certification (T-XX and T-200 Transducers)

- Wetted material for T-XX style transducers are 316SS or Inconel holders with Hastelloy-C pins, Stycast 2850 Epoxy, and glass.
- Wetted materials for T-200 Style transducers are Titanium housing and NBR (Nitrile) or FKM (Viton) O-ring material.

Only Rosemount™ specified o-ring replacements shall be used for process seal o-ring materials for T-200 transducers. No substitutions are allowed to maintain process seal integrity.

Verify chemical compatibility of material with components of process fluid.

Reference Parker Seals – Chemical Compatibility Catalog EPS 5350


Failure to select the suitable meter seals may cause escaping gases or liquids, resulting in injury or equipment damage.

Consult your Emerson Flow sales and service representative to ensure you purchase the correct components and seals for your application.

2.2 Meter components

Rosemount™ 3410 Series Gas Ultrasonic Flow Meters are assembled, configured and tested at the factory. The meter components include the transmitter electronics enclosure, the base electronics enclosure and the meter body with transducer assemblies (2).

WARNING

CONTENTS MAY BE UNDER PRESSURE

When the meter is under pressure, DO NOT attempt to remove or adjust the transducer holder.

Attempting to do so could release pressurized gases, resulting in serious injury or equipment damage.

(2) Refer to the 00809-0200-3417 Split Clamp Extractor Tool Operation Manual to remove the transducer holders while the meter is pressurized.
WARNING

CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the T-200 transducer assembly. If gas or fluid begins to leak from the T-200 transducer stalk assembly, stop immediately and reinstall T-200 stalk assembly. Failure to comply could cause serious injury or equipment damage.

A. Transducer holder

WARNING

EXPLOSION OR FIRE HAZARD
Conduit runs must have a sealing fitting within 18 inches (457 mm) of the enclosure to reduce the risk of an explosion or a fire.

• During operation, keep covers tight.
• During equipment maintenance, disconnect power before opening transmitter or base electronics. Clean cover joints before replacing.
• DO NOT substitute meter components. Component substituting may compromise the intrinsic safety.

Failure to comply could result in severe injury to personnel or cause damage to the equipment.

The 3414 four path ultrasonic meter components are shown below.
Figure 2-1: Rosemount 3414 Flow Meter assembly

A. Explosion-proof transmitter enclosure (CPU Module, Power Supply, I.S. Barrier Board)
B. Intrinsically-safe base enclosure includes Acquisition Module
C. Meter - body and transducer assemblies and cables
D. Flange stabilizers

The 3412 dual path ultrasonic meter components are shown below.
Figure 2-2: Rosemount 3412 Flow Meter assembly

A. Explosion-proof transmitter enclosure (CPU Module, Power Supply, I.S. Barrier Board, Backplane board) - (Optional: glass endcap for Local Display)
B. Intrinsically-safe base enclosure includes Acquisition Module
C. Meter - body and transducer assemblies and cables
D. Flange stabilizers

The 3411 single path ultrasonic meter components are shown below.
Figure 2-3: Rosemount 3411 Flow Meter assembly

A. Explosion-proof transmitter enclosure (CPU Module, Power Supply, I.S. Barrier Board, Backplane board) - (Optional: glass endcap for Local Display)
B. Intrinsically-safe base enclosure includes Acquisition Module
C. Meter - body and transducer assemblies and cables
D. Flange stabilizers

Figure 2-4: Transmitter electronics enclosure with optional local display and glass endcap

A. Transmitter electronics enclosure with glass endcap
B. Local display
2.3 Pipe recommendations

⚠️ WARNING

BURST HAZARD
Before pipeline cleaning and maintenance ("pigging operations"), remove straightening vanes or flow conditioners. Failure to do so may cause excessive pressure in the meter system, resulting in serious injury/death or equipment damage.

Figure 2-5: 3410 Series Gas Ultrasonic Flow Meter with flow conditioner for uni-directional flow

![Flow conditioner: Daniel Profiler or CPA 50 E Straightening device]

Figure 2-6: 3410 Series Gas Ultrasonic Flow Meter with flow conditioner for bi-directional flow

![Flow conditioner: Daniel profiler or CPA 50E Straightening device]

Sunshields, provided by the customer, may be required to prevent exceeding the process fluid temperature when the meter is mounted in a location with extremely hot climates.

⚠️ CAUTION

SUNSHIELD PROTECTION
Install a sunshield to prevent prolonged exposure to direct sunlight in extreme climates.

Failure to shield the meter may result in exceeding the process temperature range and damage transmitter electronics.
NOTICE

For optimal flow measurement conditions, Rosemount™ suggests the piping configurations below. Regardless of the configuration selected, the user agrees to accept full responsibility for the site piping design and installation.

Flow conditioning is recommended for best measurement results

- Honed or un-honed meter tube(s)
- Flow direction (unidirectional or bidirectional)
- Correct meter size selection - too low may cause poor flow stability (thermal convection or too fast may cause erosion problems and resonance, cracks or failure of probes or thermowells (approximately 0.3 to 30 m/sec or 1 to 100 ft/sec).
- Space availability for meter lengths (to allow inlet piping customization)
- Concentric alignment pins or flange concentricity technique considerations

Important
The bore of the mating piping should be within 1% of the meter inside diameter.

Figure 2-7: Piping recommendations uni-directional without flow conditioner

Figure 2-8: Piping recommendations uni-directional with flow conditioner
Figure 2-9: Piping recommendations bi-directional flow with flow conditioner

All pipe lengths are minimum:

- D = Nominal pipe size in inches (i.e. 6” pipe size; 10 D = 60 in)
- P = Pressure measurement location
- T = Temperature measurement location

**NOTICE**

Refer to the ultrasonic flow meter product datasheets: [www.emerson.com](http://www.emerson.com).

- Rosemount 3410 Series Ultrasonic Gas Flow Meters should be mounted in horizontal piping with the chord paths horizontal.

**CAUTION**

**FAULTY METER INSTALLATION**

Correctly install the equipment.

If meter bodies are mounted or oriented differently than specified above, debris or gas may collect in the transducer ports which could adversely affect the transducer signals, or cause equipment damage.

- Normally, the meter body is installed so that the electronics assembly is on the top of the meter. If there is insufficient space above the piping for this arrangement, the meter can be ordered with extra long transducer cables for remote mounting or the meter housing can be installed with the electronics assembly on the bottom.
- The mating piping should include temperature measurement connections located a minimum of three nominal pipe diameters length down stream of the meter, or per AGA Report No. 9.

### 2.4 Pre-installation inspection

Upon receipt of the meter and before installation inspect meter for signs of components loosening, seal damage or other component damage. This includes:
Procedure

1. Ensure flange sealing faces are undamaged.
2. Movement of components that should be rigid.
   If any damage is found, contact Emerson Flow services before putting meter into service. Refer to the Emerson Flow services contact information on the back cover of this manual.

2.4.1 Meter safety for hoist rings and lifting slings

A Rosemount™ Gas Ultrasonic Flow Meter can be safely lifted and maneuvered into and out of a meter run for installation or service by obeying the following instructions.

⚠️ DANGER

LIFTING A ROSEMOUNT ULTRASONIC METER WITH OTHER EQUIPMENT

The following lifting instructions are for installation and removal of the Rosemount Ultrasonic Meter ONLY.

The instructions below do not address lifting the Rosemount ultrasonic meter while it is attached, bolted, or welded to meter tubes, piping, or other fittings.

Using these instructions to maneuver the Rosemount Ultrasonic Meter while it is still attached, bolted, or welded to a meter tube, piping, or other fitting can result in death, serious injury, or equipment damage.

The operator must refer to their company's hoisting and rigging standards, or the "DOE-STD-1090-2004 Hoisting and Rigging" standard if such company standards do not exist, for lifting and maneuvering any assembled meter tube and associated piping.

⚠️ WARNING

CRUSHING HAZARD

During meter installation or removal, always place the unit on a stable platform or surface that supports its assembled weight.

Failure to comply could allow the meter to roll, resulting in serious injury or equipment damage.

NOTICE

Prior to lifting the unit, refer to the Rosemount Gas Ultrasonic Flow Meter nameplate or outline dimensional (general arrangement) drawing for the assembled weight.

When lifting a Rosemount Ultrasonic Meter by itself, Rosemount recommends two methods. These methods are:

- Using appropriately rated Safety Engineered Swivel Hoist Rings installed in the Rosemount Ultrasonic Meter end flanges.
• Using appropriately rated lifting slings positioned at designated areas of the Rosemount Ultrasonic Meter.

Both methods must be used in conjunction with all appropriate company hoisting and rigging standards or the DOE-STD-1090-2004 HOISTING AND RIGGING standard if such company standards do not exist. Refer to the following sections for more information on these two methods.

**Appropriate safety engineered swivel hoist rings in meter end flanges**

Rosemount Ultrasonic meters come equipped with a tapped hole located on the top of each meter body end flange. A flat machined surface surrounds each tapped hole. This feature provides complete surface contact ONLY between the meter flange and an OSHA compliant Safety Engineered Swivel Hoist Ring as shown in Figure 2-11.

Operators SHALL NOT use Eye Bolts (see Figure 2-12) in the Rosemount Ultrasonic Meter flange tapped holes to aid in lifting or maneuvering the unit.

Operators SHALL NOT use other Hoist Rings that do not fully seat flush with the counterbore on the top of the meter flanges.

---

**Figure 2-10: Meter end flange with tapped flat-counterbore hole for hoist ring**

A. Plug bolt
B. Flat Counterbore surface
Safety precautions using safety engineered swivel hoist rings

Read and follow the Safety Precautions listed below.

Procedure

1. Meters must only be lifted by personnel properly trained in the safe practices of rigging and lifting.
2. Remove the plug bolts installed in the tapped holes on the top of the flanges. Do not discard the bolts as they must be reinstalled once the lifting operation is complete to prevent corrosion of the tapped holes.
3. Ensure the tapped holes on the meter are clean and free of debris before installing the hoist rings.
4. Use only the safety engineered swivel hoist rings that are rated for lifting the meter. Do not use any other type of hoist rings with the same screw size or heavy duty hoist rings. The meter tapping and counter bore size are suitable only for the hoist rings specified by Rosemount™.

5. When installing a hoist ring, make sure the base surface of the hoist ring fully contacts the machined flat surface of the tapped hole. If the two surfaces do not come in contact then the hoist ring will not hold its full rated load. Torque the hoist ring attachment bolts to the limit indicated on the hoist rings.

6. After installation of the hoist rings, always check that the ring rotates and pivots freely in all directions.

7. NEVER attempt to lift the meter using only one hoist ring.

8. Always use separate slings to each hoist ring. NEVER reeve one sling through both hoist rings. The slings must be of equal length. Each sling must have a load rating that equals or exceeds the hoist ring load rating. The angle between the two slings going to the hoist rings must never exceed 90 degrees or the load rating of the hoist rings will be exceeded.

---

**Figure 2-13: 90 Degree angle between slings**

9. NEVER allow the slings to contact the electronics enclosure. Damage to the enclosure may occur. Use a spreader bar with the slings to prevent contact with the electronics enclosure and the base enclosure (see Safety)
precautions using appropriate rated lifting slings). If the slings do come in contact with the electronic enclosure, then remove the two bolts holding the enclosure to its base and temporarily remove the head from the meter during the lifting operation. You will need to unplug the cable from J3 on the Acquisition Module. Two screws hold this cable in place.

a) Once the lifting operation is complete, reattach and secure the electronics cable to J3 on the Acquisition Module, return the electronics enclosure to its original position, replace the bolts, and secure the enclosure in place.

⚠️ CAUTION

FALL HAZARD
Lifting the meter with the upper enclosure installed but without the bolts installed, may cause the electronics to fall and cause personal injury or equipment damage.

Figure 2-14: Incorrect sling attachment

10. NEVER apply shock loads to the meter. Always lift the meter gradually. If shock loading ever occurs, the hoist ring must be inspected per manufacturer’s recommendations prior to any further service. If a proper inspection cannot be performed, discard the hoist ring.

11. NEVER lift with any device, such as hooks, chains, or cables that could create side pulls that could damage the ring of the hoist ring.
12. NEVER lift more than the ultrasonic meter assembly including electronics and transducers with the hoist rings. The only exception that safe is to lift the meter with one ASME B16.5 or ASME B16.47 blind flange bolted to each end flange of the meter. NEVER use the hoist rings on the meter to lift other components such as meter tubes, piping or fittings attached to the meter. Doing so will exceed the load rating of the hoist rings.

13. Remove the hoist rings from the meter after lifting is completed and store them in an appropriate case or container per their manufacturer’s recommendation.

14. Apply heavy lubricant or anti-seize to the threads of the plug bolts and reinstall the plug bolts to keep the tapped holes free of debris and to prevent corrosion.

Obtain safety engineered swivel hoist rings

A list of approved manufacturers of safety engineered hoist rings is below:

- American Drill Bushing Company (http://www.americandrillbushing.com)
- Carr Lane Manufacturing Company (http://www.carrlane.com)

Select an approved supplier from the list below. These vendors can supply the safety engineered hoist rings. This is not intended to be a complete list.

- Fastenal (http://www.fastenal.com)
- Reid Tools (http://www.reidtool.com)

The appropriate hoist rings can also be purchased directly from Rosemount™. The following table provides part numbers for reference:

Table 2-1: Hoist ring part number lookup table

<table>
<thead>
<tr>
<th>Rosemount part number (1)</th>
<th>Hoist ring thread size &amp; load rating (1)</th>
<th>American Drill Bushing Co. P/N (1)</th>
<th>Carr Lane Manufacturing Co. P/N (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-504-90-091</td>
<td>3/8&quot;-16UNC, 1000 lb.</td>
<td>23053</td>
<td>CL-1000-SHR-1</td>
</tr>
<tr>
<td>1-504-90-092</td>
<td>1/2&quot;-13UNC, 2500 lb.</td>
<td>23301</td>
<td>CL-23301-SHR-1</td>
</tr>
<tr>
<td>1-504-90-093</td>
<td>3/4&quot;-10UNC, 5000 lb.</td>
<td>23007</td>
<td>CL-5000-SHR-1</td>
</tr>
<tr>
<td>1-504-90-094</td>
<td>1&quot;-8UNC, 10000 lb.</td>
<td>23105</td>
<td>CL-10000-SHR-1</td>
</tr>
<tr>
<td>1-504-90-095</td>
<td>1-1/2&quot;-6UNC, 24000 lb.</td>
<td>23202</td>
<td>CL-24000-SHR-1</td>
</tr>
</tbody>
</table>

(1) The part numbers include only one hoist ring. Two hoist rings are required per meter.

Needed size for safety engineered swivel hoist rings

To determine the size of the hoist rings required for your meter, use the appropriate table below. Look down the column that matches the ANSI rating of your meter. Find the row that contains your meter size. Follow the row to the end to find the appropriate hoist ring part number.
Table 2-2: Hoist Ring Lookup Table for Rosemount 3414 Gas Meters(1)

<table>
<thead>
<tr>
<th>ANSI 300</th>
<th>ANSI 600</th>
<th>ANSI 900</th>
<th>ANSI 1500</th>
<th>Rosemount Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>4&quot; to 10&quot;</td>
<td>4&quot; to 8&quot;</td>
<td>4&quot; to 8&quot;</td>
<td>4&quot; to 6&quot;</td>
<td>1-504-90-091</td>
</tr>
<tr>
<td>12&quot; to 18&quot;</td>
<td>10&quot; to 16&quot;</td>
<td>10&quot; to 12&quot;</td>
<td>8&quot; to 10&quot;</td>
<td>1-504-90-092</td>
</tr>
<tr>
<td>20&quot; to 24&quot;</td>
<td>18&quot; to 20&quot;</td>
<td>16&quot; to 20&quot;</td>
<td>12&quot;</td>
<td>1-504-90-093</td>
</tr>
<tr>
<td>30&quot; to 36&quot;</td>
<td>24&quot; to 30&quot;</td>
<td>24&quot;</td>
<td>16&quot; to 20&quot;</td>
<td>1-504-90-094</td>
</tr>
<tr>
<td>36&quot;</td>
<td>30&quot; to 36&quot;</td>
<td>24&quot; to 36&quot;</td>
<td></td>
<td>1-504-90-095</td>
</tr>
</tbody>
</table>

(1) 4" to 6" 45 degree meters, 8" to 24" 60 degree meters and 26" and above 75 degree meters.

Table 2-3: Hoist Ring Lookup Table for Rosemount 3411 or 3412 Gas Meters

<table>
<thead>
<tr>
<th>ANSI 300</th>
<th>ANSI 600</th>
<th>ANSI 900</th>
<th>ANSI 1500</th>
<th>Rosemount Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>4&quot; to 12&quot;</td>
<td>4&quot; to 8&quot;</td>
<td>4&quot; to 8&quot;</td>
<td>4&quot; to 6&quot;</td>
<td>1-504-90-091</td>
</tr>
<tr>
<td>16&quot; to 18&quot;</td>
<td>10&quot; to 16&quot;</td>
<td>10&quot; to 12&quot;</td>
<td>8&quot; to 10&quot;</td>
<td>1-504-90-092</td>
</tr>
<tr>
<td>20&quot; to 30&quot;</td>
<td>18&quot; to 20&quot;</td>
<td>16&quot; to 20&quot;</td>
<td>12&quot;</td>
<td>1-504-90-093</td>
</tr>
<tr>
<td>36&quot;</td>
<td>24&quot; to 30&quot;</td>
<td>24&quot;</td>
<td>16&quot; to 20&quot;</td>
<td>1-504-90-094</td>
</tr>
<tr>
<td>36&quot;</td>
<td>30&quot; to 36&quot;</td>
<td>24&quot; to 36&quot;</td>
<td></td>
<td>1-504-90-095</td>
</tr>
</tbody>
</table>

Appropriate rated lifting slings

The following instructions are intended to provide general guidelines for using proper lifting slings when lifting a Rosemount 3410 Series Gas Ultrasonic Flow Meter by itself. These instructions are intended to be followed in addition to your company’s standards or the DOE-STD-1090-2004 Hoisting and Rigging standard if such company standards do not exist.

Safety precautions using appropriate rated lifting slings

Procedure

1. Meters must only be lifted by personnel properly trained in the safe practices of rigging and lifting.
2. NEVER attempt to lift the meter by wrapping slings around the electronics enclosure.
3. NEVER attempt to lift the meter using only one sling around the meter. Always use two slings wrapped around each end of the body as shown below. A choker style sling is recommended.
4. Visually inspect the slings prior to use for any signs of abrasion or other damage. Refer to the sling manufacturer's procedures for proper inspection of the particular sling you are using.

5. Only use slings with ratings that exceed the weight to be lifted. Reference your company's standards for safety factors that must be included when calculating the load rating.

6. NEVER allow the slings to contact the electronics enclosure or the transducer cabling. Damage to the meter may occur. If the slings do come in contact with the electronics enclosure, then remove the two bolts holding the enclosure to its base and temporarily remove the head from the meter during the lifting operation (Remove the two bolts holding the enclosure to its base and unplug the cable from the Acquisition Module. Two screws hold this cable in place.) Use a spreader-bar on the slings to prevent contact with the electronics.

7. Once the lifting operation is complete, reattach and secure the electronics cable to J3 on the Acquisition Module, return the electronics enclosure to its original position, replace the bolts, and secure the enclosure in place. Lifting the meter with the upper enclosure installed but without the bolts installed, may cause the electronics to fall and cause personal injury or electronics damage.
8. NEVER apply shock loads to the meter. Always lift the meter gradually. If shock loading ever occurs, the slings must be inspected per manufacturer’s procedures prior to being placed in any further service.

2.5 Mounting requirements in heated or cooled pipelines

The ambient operating temperature of the Rosemount™ 3410 Series Gas Ultrasonic Flow Meter electronics (i.e. Flameproof enclosure and Intrinsically safe base enclosure) is -40 °C (-40 °F) to +60 °C (+140 °F).

If the meter is installed into a pipeline which is heated or cooled outside this temperature range it is necessary to remove the electronics housing from the meter body (i.e. Spool piece acting as process fluid conduit) and mount it next to the meter body on a pipe stand or other rigid structure.

Extended length transducer cables (P/N 2-3-3400-194, 15 ft. long) shall be used to connect the Rosemount 3410 Series Gas Ultrasonic Flow Meter electronics to the transducers installed in the meter body. The process temperature must also not exceed the operating temperature range of the transducers. T-11, T-12 and T-21 transducers have an operating range from -4 °F (-20 °C) to 212 °F (+100 °C). T-22
transducers have an operating range from -58 °F (-50 °C) to 212 °F (+100 °C). T-200 transducers have an operating range from -58 °F (-50 °C) to 257 °F (+125 °C).

⚠️ CAUTION

SURFACE TEMPERATURE HAZARD
The meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.
3 Electrical installation

3.1 Cable length TTL mode

The maximum cable length is 2000 feet when the Digital Output “TTL” mode is selected.

3.2 Cable length Open Collector mode

For the Digital Output “open collector” mode, the maximum cable length depends on the cable parameters, pull-up resistance used, the maximum frequency to output, and frequency input parameters being driven. The following table provides estimated cable lengths for different pull-up resistor values and different Max Frequency settings in the meter using the following cable parameters. The table also provides an estimated cable voltage drop which indicates how much voltage will be across the cabling and effectively indicates to what voltage level the frequency input can be pulled down to by the frequency output.

If the voltage drop is higher than the voltage required for the frequency input to see a low state, then the configuration will most likely not work for your system. Performance of frequency outputs will vary from this table with setup and frequency input being driven.

Table 3-1: Configurations for open collector frequency outputs

<table>
<thead>
<tr>
<th>Cable Length (x1000ft)</th>
<th>Cable Resistance (Ω)</th>
<th>Capacitance (nF)</th>
<th>Pull-up Resistance (Ω)</th>
<th>Total Resistance (Ω)</th>
<th>Maximum Frequency (Hz)</th>
<th>Sink Current (A)</th>
<th>Cable Voltage Drop (VDC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>16.8</td>
<td>10.00</td>
<td>1000</td>
<td>1016.8</td>
<td>5000</td>
<td>0.024</td>
<td>0.397</td>
</tr>
<tr>
<td>1</td>
<td>33.6</td>
<td>20.00</td>
<td>1000</td>
<td>1033.6</td>
<td>1000</td>
<td>0.023</td>
<td>0.780</td>
</tr>
<tr>
<td>2</td>
<td>67.2</td>
<td>40.00</td>
<td>1000</td>
<td>1067.2</td>
<td>1000</td>
<td>0.022</td>
<td>1.511</td>
</tr>
<tr>
<td>4</td>
<td>134.4</td>
<td>80.00</td>
<td>1000</td>
<td>1134.4</td>
<td>1000</td>
<td>0.021</td>
<td>2.843</td>
</tr>
<tr>
<td>0.5</td>
<td>16.8</td>
<td>10.00</td>
<td>500</td>
<td>516.8</td>
<td>5000</td>
<td>0.046</td>
<td>0.780</td>
</tr>
<tr>
<td>1</td>
<td>33.6</td>
<td>20.00</td>
<td>500</td>
<td>533.6</td>
<td>5000</td>
<td>0.045</td>
<td>1.511</td>
</tr>
<tr>
<td>1.7</td>
<td>57.12</td>
<td>34.00</td>
<td>500</td>
<td>557.12</td>
<td>5000</td>
<td>0.043</td>
<td>2.461</td>
</tr>
<tr>
<td>6.5</td>
<td>218.4</td>
<td>130.00</td>
<td>500</td>
<td>718.4</td>
<td>1000</td>
<td>0.033</td>
<td>7.296</td>
</tr>
</tbody>
</table>

The 22 AWG wire characteristics:
- Capacitance = 20 pF/ft or 20 nF/1000 ft (between two wires)
• Resistance = 0.0168 Ohms/ft or 16.8 Ohms/1000 ft
• Pull-up voltage = 24 VDC

### 3.3 Grounding meter electronics housing

The meter electronics should be internally grounded for intrinsically safe operations. Connect a wire to the chassis ground lug installed inside the Transmitter Electronics Enclosure as the primary ground. A secondary ground is located outside of the Transmitter Electronics Enclosure (see Figure 3-2).

**NOTICE**

The internal grounding terminal shall be used as the primary equipment ground. The external terminal is only a supplemental bonding connection where local authorities permit or require such a connection. DO NOT connect digital grounds to the ground lugs.

**Figure 3-1: Internal Transmitter Electronics Enclosure chassis ground**

A. Transmitter Electronics Enclosure ground lug
3.4 Conduit seals

Conduit seals are required for meter installations in hazardous environments. Adhere to safety instructions to protect personnel and equipment.

⚠️ WARNING

EXPLOSION HAZARD
To reduce the risk of an explosion or fire, conduit runs must have a sealing fitting connected within 457.2 mm (18 inches) of the enclosure. Substitution of components may impair intrinsic safety of the meter.
Failure to keep covers tight during operation could result in death or serious injury.

⚠️ WARNING

EXPLOSION HAZARD
Substitution of components may impair the intrinsic safety and cause ignition of flammable or combustible atmospheres. Disconnect power before servicing.
Failure to remove power and use Rosemount™ approved components could cause serious injury.

⚠️ WARNING

CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer holder.
Attempting to do so could release pressurized gases, resulting in serious injury or equipment damage.
3.4.1 Startup for systems that use explosion-proof conduit

Procedure

1. Assemble conduit to the Transmitter Electronics Enclosure. A conduit seal fitting is required within 18 inches (457 mm) of the enclosure.
2. Check to make certain that all power to field wiring is turned OFF.

⚠️ WARNING

HAZARDOUS VOLTAGE INSIDE
Do not open the Transmitter Electronics Enclosure when an explosive gas atmosphere is present. Disconnect equipment from supply circuit before opening the enclosure.
Failure to remove power could result in serious death or injury.

3. Remove the end cap nearest the conduit entry to gain access to the transmitter electronics.
4. Pull the wires into the electronics enclosure. Complete the field connection wiring as shown in see Figure 3-3 and Wiring and inputs/outputs.
5. Complete the field connection wiring and apply electrical power to the system.
**Figure 3-3: Electronics field wiring - upper terminal block, switches, ground lug - Type 2 CPU Module**

<table>
<thead>
<tr>
<th>A. Conduit wiring entry (four entries)</th>
<th>B. Switches:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Port A</td>
</tr>
<tr>
<td></td>
<td>2. DHCP</td>
</tr>
<tr>
<td></td>
<td>3. WRITE PROT.</td>
</tr>
<tr>
<td>C. Upper terminal block</td>
<td></td>
</tr>
<tr>
<td>a. FODO Group 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• FODO2</td>
</tr>
<tr>
<td></td>
<td>• GND2</td>
</tr>
<tr>
<td></td>
<td>• FODO3</td>
</tr>
<tr>
<td>b. Analog Out (Current 4-20mA)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• AO2+</td>
</tr>
<tr>
<td></td>
<td>• AO2 -</td>
</tr>
<tr>
<td>c. Analog In</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Analog In (AI1)</td>
</tr>
<tr>
<td></td>
<td>— Analog Input 1 (Temperature)</td>
</tr>
<tr>
<td></td>
<td>• TT+</td>
</tr>
<tr>
<td></td>
<td>• TT -</td>
</tr>
<tr>
<td></td>
<td>• Analog In (AI2)</td>
</tr>
<tr>
<td></td>
<td>— Analog Input 2 (Pressure)</td>
</tr>
<tr>
<td></td>
<td>• PT+</td>
</tr>
<tr>
<td></td>
<td>• PT -</td>
</tr>
<tr>
<td>D. Ground lug</td>
<td></td>
</tr>
</tbody>
</table>
Figure 3-4: Transmitter electronics field wiring lower terminal block - Type 2 CPU Module

A. Lower Terminal Block
a. FODO Group 1 connections
   - FODO1
   - GND1
   - DI 1
b. AO1
   - AO1+
   - AO1-
c. Serial COMs (RS-323, RS-485)
   - RS-323: RTS, TX, RX, CTS
   - RS-485: TX+, TX-, RX+, RX- (4-wire Full Duplex)
   - RS-485: TX+, TX- (2-wire Half Duplex)

d. Ethernet
   - Ethernet (orange and white wire)
   - Ethernet (orange wire)
   - Ethernet (green and white wire)
   - Ethernet (green wire)
B. 24 V loop power (for sourcing 4-20 mA inputs/outputs)
C. Power in (10.4 VDC - 36 VDC)
D. Fuse cover
Figure 3-5: Electronics field wiring - upper terminal block, switches, ground lug - Type 4CPU Module

A. Conduit wiring entry (four entries)
B. Switches:
  1. Port A
  2. DHCP
  3. WRITE PROT.
C. Upper terminal block
   a. FODO Group 2
      • FODO2
      • FODO3
      • GND2
      • GND2
      • FODO4
      • FODO5
   b. Analog In
      • Analog In (AI1)
        — Analog Input 1 (Temperature)
          • TT+
          • TT -
      • Analog In (AI2)
        — Analog Input 2 (Pressure)
          • PT+
          • PT -
D. Ground lug
6. Set or configure the meter operating parameters using MeterLink. For additional installation information refer to the system wiring diagram (see Electrical installation Installation manual January 2023 00825-0600-3104 52 Gas Ultrasonic Flow Meters).
3410 Series engineering drawings), MeterLink Software for Gas and Liquid Ultrasonic Meters Quick Start Manual (00809-0100-7630) and use the MeterLink Field Setup Wizard to complete the configuration.

7. Verify the field connections are working correctly. Allow the system to run for the time specified by the customer (usually one week) and an electrician has fully tested the connections. After the Acceptance Test is witnessed and approved, seal the conduit.

8. Power down the system and apply the sealing compound to the conduit and allow to set in accordance with manufacturer specifications.

9. If required, install the security latches and wire seals on the Transmitter Electronics Enclosure end caps (see Seal transmitter electronics enclosure).

10. If required, install the wire seals through the socket head bolts on the Base Enclosure (see Base enclosure security seals).

11. Re-apply electrical power to the system.

3.4.2 Startup for systems that use flame-proof cable

**WARNING**

HAZARDOUS VOLTAGE INSIDE
Do not open the Transmitter Electronics Enclosure when an explosive gas atmosphere is present. Disconnect equipment from supply circuit before opening the enclosure.

Failure to remove power could result in serious death or injury.

**Procedure**

1. Check to make certain that all field wiring power is turned OFF.

2. Remove the end cap nearest the cable entries to gain access to the transmitter electronics.

3. Install the cable and cable gland.

4. Complete the field connection wiring and apply electrical power to the system.

5. Set or configure the meter operating parameters using MeterLink. For additional installation information refer to the system wiring diagram (see 3410 Series engineering drawings), MeterLink Software for Gas and Liquid Ultrasonic Meters Quick Start Manual (00809-0100-7630) and use the MeterLink Field Setup Wizard to complete the configuration.

6. Verify the field connections are working correctly. Allow the system to run for the time specified by the customer (usually one week) and an electrician has fully tested the connections. After the Acceptance Test is witnessed and approved, seal the conduit.

7. Power down the system and apply the sealing compound to the conduit and allow to set in accordance with manufacturer specifications.

8. If required, install the security latches and wire seals on the Transmitter Electronics Enclosure end caps (see Security seal installation and Base enclosure security seals).
9. If required, install the wire seals through the socket head bolts on the Base Enclosure (see Security seal installation, Figure 3-22 and Figure 3-23).
10. Re-apply electrical power to the system.

3.5  
Wiring and inputs/outputs

MeterLink uses the TCP/IP protocol to communicate with the Rosemount™ 3410 Series Ultrasonic Gas Flow Meter electronics instead of Modbus ASCII or RTU. The TCP/IP protocol only works across either Ethernet, RS-485 full duplex (4-wire) or RS-232. MeterLink can communicate with multiple meters if they are multi-dropped using 4-wire, full duplex RS-485 mode. The meter electronics is HART capable and provides communication flexibility with Rosemount 3410 Series Gas Ultrasonic Flow Meters.

**Note**
Port B for RS-485 full duplex communication is not supported.

The HART® output provides communication with other field devices (e.g., Field Communicator and AMS™ Device Manager software) and ultimately, communicates key diagnostic information through PlantWeb® architecture.

**NOTICE**
If not using Ethernet, a full duplex serial connection is necessary for MeterLink to communicate with a Rosemount™ 3410 Series Gas Ultrasonic Meter.

The Rosemount 3410 Series Gas Ultrasonic Flow Meter electronics auto-detects the protocol used and automatically switches between TCP/IP, Modbus ASCII, and Modbus RTU so it is not necessary to make any meter configuration changes to the protocol.

3.5.1  
CPU Module labeling and LED indicators

The meter’s metrology mode and the status of the data transfer from the Acquisition Module to the CPU Module are indicated via light-emitting diode (LED) status indicators. The **WRITE PROT** switch protects the meter’s configuration.
Figure 3-7: CPU Module labeling and LED indicators - Type 2

A. Acquisition/Measurement mode
B. Power
C. LED 5 - communication between CPU and Acquisition Module
D. LED 4 - link between CPU and Acquisition Module
E. RX (RS-485/RS-232) - receiving data
F. TX (RS-485/RS-232) - transmitting data (RS-485 2-wire use TX+ and TX-)
G. Link (Eth1 Link) - user Ethernet connection

Figure 3-8: CPU Module labeling and LED indicators - Type 4

A. Acquisition/Measurement mode
B. Power
C. LED 5 - communication between CPU and Acquisition Module
D. LED 4 - link between CPU and Acquisition Module
E. RX (RS-485/RS-232) - receiving data
F. TX (RS-485/RS-232) - transmitting data (RS-485 2-wire use TX+ and TX-)
G. Link (Eth1 Link) - user Ethernet connection
### Table 3-2: CPU Module labeling and LED functions

<table>
<thead>
<tr>
<th>CPU Module label or LED</th>
<th>Function</th>
<th>Switch position indicator or LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>WRITE PROT.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
|                        | • Write-protect mode - with switch in the **ON** position (default setting) protects configuration and firmware overwrites.  
• To write configuration changes or download firmware to the meter change the switch to the **OFF** position. | Switch position  
• **ON** - (default setting) enables write protection of the configuration and firmware  
• **OFF** - enables writing configuration changes or downloading firmware |
| DHCP                   |          |                                  |
|                        | • Dynamic Host Protocol Server - enables you to communicate with a Rosemount™ meter that is not connected to a network.  
• When the CPU Module switch is in the **ON** position, the meter is enabled to act as a DHCP server for a single DHCP client connected to the Ethernet port using a crossover cable. This should be used for peer to peer connections only.  
• When the connection is made, select to use the Meter Name in the meter instead of the Meter Directory Name in order to keep all log files and configurations separate from each meter. | Switch position  
• **ON** - the meter is enabled to act as a DHCP server for a single DHCP client  
• **OFF** - disables the DHCP server |
Table 3-2: CPU Module labeling and LED functions (continued)

<table>
<thead>
<tr>
<th>CPU Module label or LED</th>
<th>Function</th>
</tr>
</thead>
</table>
| PORT A                  | • PORT A override - RS-232 serves as an override during meter commissioning to establish communications and in the event the user cannot communicate with the meter due to an inadvertent communication configuration change. The override period is for two minutes.  
  • Supports:  
    — auto-detected ASCII (Start bit 1, Data Bit 7, Parity Odd/Even, Stop Bit 1)  
    — RTU (Start Bit 1, Data Bit 8, Parity none, Stop Bit 1)  
    — Modbus protocols  
  • RS-232 Baud rate=19,200  
  • Modbus ID=32 |

<table>
<thead>
<tr>
<th>Function</th>
<th>Switch position indicator or LED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switch position</td>
</tr>
</tbody>
</table>
|                           | • ON - enables RS-232 PORT A override  
  • OFF - (default setting) disables RS-232 PORT A override |
|                           | LED status                       |
|                           | • Red flashing LED, the meter is in acquisition mode.  
  • Solid red, the Acquisition Module is not communicating with the CPU Module.  
  • Green flashing LED. |
| MEAS                      | System color indicates metrology mode  
  • Acquisition mode  
  • Measurement mode |
| PWR                       | 3.3 V Power Indicator | Solid green |
| LED 4                     | Not used                         | Solid green LED |
| LED 5                     | Not used                         | Solid green LED |
| RX                        | RX signal (Port A for RS485 or RS232 communication) receiving data | Flashing green (when receiving data) |
| TX                        | TX signal (Port A for RS485; 2-wire or 4-wire or RS232 communication) transmitting data | Flashing green (when transmitting data) |
| Link                      | ETH1Link user Ethernet connection | Solid green |
Ethernet communications

The Ethernet port IP address, subnet mask, and gateway address are software-configurable. In addition, a meter can be configured to act as a DHCP (Dynamic Host Configuration Protocol) server to assign an IP address to a PC or laptop running MeterLink. The DHCP server facility is not intended to act as a general purpose DHCP server for a wider network. To this end, no user control is provided over the class or range of IP addresses the unit provides. A standard twisted pair (Cat-5) cable should be used for Ethernet wiring.

It is strongly recommended that the meter be configured using an independent (off-network) single host. After configuration of the Rosemount™ 3410 Series Gas Ultrasonic Flow Meter, the DHCP option must be turned off if used on a LAN/WAN.

**NOTICE**

RESTRICTED ETHERNET AND SERIAL CONNECTIVITY USAGE

Failure to restrict Ethernet and communication access to the Rosemount™ 3410 Series Gas Ultrasonic Flow Meter can result in, among other things, unauthorized access, system corruption, and/or data loss.

User is responsible for ensuring that physical access and Ethernet or electronic access to the Rosemount 3410 Series Gas Ultrasonic Flow Meter is appropriately controlled and any necessary security precautions are implemented; such as, establishing a firewall, setting password permissions and/or implementing security levels.

**Table 3-3: Ethernet cable to PC communication**

<table>
<thead>
<tr>
<th>Ethernet communication</th>
<th>Wire color</th>
<th>CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>White w/Orange Stripe</td>
<td>TX+</td>
</tr>
<tr>
<td></td>
<td>Orange w/White Stripe</td>
<td>TX -</td>
</tr>
<tr>
<td></td>
<td>White w/Green Stripe</td>
<td>RX+</td>
</tr>
<tr>
<td></td>
<td>Green w/White Stripe</td>
<td>RX -</td>
</tr>
</tbody>
</table>

Use Ethernet cable, Rosemount P/N 1-360-01-596, to connect the PC to the meter.
A DIN 41612 48-pin connector is the interface from the CPU Module to the Field Connection Board (male end located on the back of the Field Connection Board).

**Cybersecurity and network communications**

The 3410 electronics TCP/IP communications should be configured to mitigate cybersecurity risks as follows:

1. MeterLink uses either FTP or HTTP protocols for Archive and Smart Meter Verification log collection. It is recommended to disable the FTP protocol and leave the HTTP protocol enabled using the **Meter → Communications Settings** dialog in MeterLink. Both can be disabled for additional security, but log collection will not be possible in this configuration.

2. Telnet port should be left disabled. This port is not required for any communications to field devices or MeterLink. Beginning with Rosemount 3410 Series Firmware v1.60, Telnet is permanently disabled.

3. Enabling the physical Write Protect switch will prevent metrology configuration changes and firmware upgrades. It will also prevent enabling TCP/IP protocols such as FTP, HTTP, and Telnet.

4. Disable unused protocols or set them to read-only if write capability is not required. The Modbus TCP/IP protocol can be set to Read-only or Disabled on the Ethernet port. Modbus protocols can be disabled or made read-only on serial ports while still allowing authenticated MeterLink communications.

5. Rosemount 3410 Series Firmware v1.60 and later require user authentication and has a default administrator password. While the password is unique to each meter, it is highly recommended to be changed at meter startup. For added security, the default username, administrator, can be changed as well.

6. Other users can be added with different privileges and passwords in the Rosemount 3410 Series Firmware v1.60 and later. Only give users privileges to perform their job functions. See Manage users for more details on how to add, change, and delete users.

This transmitter:

1. Is not intended to be directly connected to an enterprise or to an internet facing-network without a compensating control in place.

2. Should be installed following industry best practices for cybersecurity.

**Modbus TCP**

If the meter firmware supports Modbus TCP slave functionality, the following controls will be available.

*Modbus TCP unit identifier:* Enter the Modbus TCP unit identifier here. Valid values are 0-255.

*Enable alternate Modbus TCP port:* The standard TCP port for Modbus TCP is port 502. This port is always enabled in a meter that supports Modbus TCP. By
selecting this option, you can also enable Modbus TCP communications on a secondary TCP port specified by Alternate Modbus TCP port.

**Alternate Modbus TCP port:** Enter the alternate TCP port number here after selecting Enable alternate modbus TCP port. Valid port numbers are from 1 to 65535. The meter will not allow some port numbers that are either used by the meter or are defined port numbers for other protocols. MeterLink™ will prompt you if it was not able to write the specified port number to the meter.

**Serial connections**

Use a serial cable, Rosemount™ P/N 3-2500-401, to connect to a PC running MeterLink. The cable is designed for RS-232 communications which is the serial Port A default configuration (see 3410 Series engineering drawings field wiring diagram, Rosemount Drawing DMC-005324). The DB-9 end of the cable plugs directly into the PC running MeterLink. The three wires on the other end of the cable connect to the CPU Module RS-485/RS-232 terminals. The RED wire goes to RX, the WHITE wire goes to TX, and the BLACK wire goes to COM (see Figure 3-9 for Port A wiring). RS-485, 2-wire connection on Port A, uses TX+ and TX- on the CPU Module and has a ground wire.

When Beldon wire No. 9940 or equivalent is used, the maximum cable length for RS-232 communications at 9600 bps is 88.3 meters (250 ft.) and the maximum cable length for RS-485 communication at 57600 bps is 600 meters (1970 ft.).

Port A supports a special override mode which forces the port to use known communication values (19200 baud, address 32, RS-232). Note that the protocol is auto-detected. This mode is expected to be used during meter commissioning (to establish initial communication) and in the event that the user cannot communicate with the meter (possibly due to an inadvertent communication configuration change). Alternately, when using MeterLink™ with an Ethernet port, use Ethernet cable, Rosemount P/N 1-360-01-596, to connect the PC.

Each serial port can be independently configured as read only in meter serial connection settings. Read only serial ports prevent write access, program downloads, alarm acknowledgements and testing of outputs. The read only serial port setting is configurable through Edit → Compare Page by modifying configuration point ReadWriteModePortA, B or C, and changing to Read-only mode.
### Table 3-4: Serial Port A parameters

<table>
<thead>
<tr>
<th>Port/Communication</th>
<th>Description</th>
<th>Common features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port A (Standard)</td>
<td>- RS-232</td>
<td>- Communications via MeterLink using RS-232 or RS-485 Full Duplex</td>
</tr>
<tr>
<td></td>
<td>- RS-485 Half Duplex</td>
<td>- Software configurable Modbus Address (1-247)</td>
</tr>
<tr>
<td></td>
<td>- RS-485 Full Duplex</td>
<td>- Auto-detects TCP/IP and ASCII or RTU Protocol</td>
</tr>
<tr>
<td></td>
<td>- RS-485 (1) (2-wire communication on Port A)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Typically used for general communications with a flow computer, RTU (Modbus slave) and radios.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- RS-485 - 2-wire (Half Duplex) connected to TX+ and TX-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Special override mode to force port configuration to known settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Supports RTS/CTS handshaking with software-configurable RTS on/off delay times.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Factory default is RS-232, Address32, 19200 baud</td>
<td></td>
</tr>
</tbody>
</table>

1. RS-485 2-wire connections use TX+ and TX- on the CPU Module.
2. Denotes auto-detected protocols.

**NOTICE**

If not using Ethernet, a full duplex serial connection is necessary for MeterLink to communicate with a Rosemount™ 3410 Series Gas Ultrasonic Meter.
3.5.2 Input/output connections

The Rosemount™ 3410 Series Gas Ultrasonic Flow Meter provides the I/O connections on the CPU Module.

A. Frequency/Digital Output 2
B. Frequency/Digital Output 3
C. Analog Output 2 - 4-20 mA output
D. Analog Input - Temperature and pressure connections
**Figure 3-11: CPU Module I/O connections - Type 4**

A. Frequency/Digital Output 2  
B. Frequency/Digital Output 3  
C. Frequency/Digital Output 4  
D. Frequency/Digital Output 5  
E. Analog Input - Temperature and pressure connections

**Optional input and output modules**

These modules are plugged into the second or third slot (retrofit) on the electronics head. These module options consist of an RS-232, RS-485 serial port modules or Expansion I/O Module. Expansion I/O Module should only be used with Type 4 CPU Module (1-360-03-065).

These modules allow expanding I/O capabilities of the meter to include extra serial ports. There are three options currently available. Serial RS-232 without handshaking, serial RS-485 Half-duplex, or RS-232/RS-485, with 3 port Ethernet Switches. For the standard enclosure offering, one serial module can be added. This serial module would become Port B. For users with retrofit enclosure option, then two serial modules can be added. These serial modules would be designated Port B and Port C based on slot installed.
Figure 3-12: Optional module RS-232

A. Serial COMs (RS-232)
B. RS-232: RTS, TX, RX
Figure 3-13: Optional module RS-485

A. Serial COMs (RS-485)
B. RS-485: TX+, TX- (2-wire Half Duplex)
A. Expansion I/O Module
B. RS-232: RX, TX, COM/RS-485: TX+, TX- (2-wire Half Duplex)
C. 4-20 mA Input - AI3+/- (future use)
D. Port Ethernet switch
   A. D1. Port 1
   B. D2. Port 2
   C. D3. Port 3
### Table 3-5: Expansion I/O to RJ45 wiring

<table>
<thead>
<tr>
<th>Ethernet communication</th>
<th>Wire color</th>
<th>CPU/EXP</th>
<th>TX+</th>
<th>TX-</th>
<th>RX+</th>
<th>RX-</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>White w/Green Stripe</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Solid Green</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>White w/Orange stripe</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Solid orange</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Wiring colors for TX+/TX- and RX+/RX- can be switched as ethernet ports will automatically detect crossover vs. straight connection. Connections shown are for straight through cable.

### Figure 3-15: PC to meter serial connection wiring - RS-232

![DB-9 Connector Female](image)
Table 3-6: Optional modules parameters

<table>
<thead>
<tr>
<th>Description</th>
<th>Common features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port B/Port C (Optional module)</td>
<td>• Typically used for general communications with a flow computer, RTU (Modbus slave) and radios.</td>
</tr>
<tr>
<td>• RS-232 - P/N: 1-360-024</td>
<td>• Communications via MeterLink using RS-232</td>
</tr>
<tr>
<td>• RS-485 Half Duplex - P/N 1-360-03-023</td>
<td>• Software configurable Modbus Address (1-247)</td>
</tr>
<tr>
<td>• Expansion I/O Module - P/N 1-360-03-026 (232/485 Half Duplex, Ethernet switch)</td>
<td>• Auto-detects TCP/IP and ASCII or RTU Protocol</td>
</tr>
<tr>
<td>• Factory default is RS-232, Address32, 19200baud</td>
<td>— ASCII Protocol:</td>
</tr>
<tr>
<td></td>
<td>• Start Bits = 1, Data Bits = 7 (^{(1)})</td>
</tr>
<tr>
<td></td>
<td>• Parity: odd or even 1, Stop Bits = 1 (^{(1)})</td>
</tr>
<tr>
<td></td>
<td>• Baud Rates: 1200, 2400, 9600, 19200, 38400, 57600, 115000 bps</td>
</tr>
<tr>
<td></td>
<td>— RTU Protocol:</td>
</tr>
<tr>
<td></td>
<td>• Start Bits = 1, Data Bits = 8 (^{(1)})</td>
</tr>
<tr>
<td></td>
<td>• Parity: odd or even 1, Stop Bits = 1 (^{(1)})</td>
</tr>
<tr>
<td></td>
<td>• Baud Rates: 1200, 2400, 9600, 19200, 38400, 57600, 115000 bps</td>
</tr>
<tr>
<td></td>
<td>• Software configurable as Read-only</td>
</tr>
</tbody>
</table>

Note
Port C is only available with Retrofit Enclosure.

(1) Denotes auto-detected protocols.

Note
Use of FODO6 requires DI1Mode set to Frequency/Digital Output 6. Digital Input will not be available.

Figure 3-16: Expansion I/O LED indicators

<table>
<thead>
<tr>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. TX/RX for RS232/RS485 serial port</td>
<td>Flashing (Orange - RX/Green - TX)</td>
</tr>
<tr>
<td>B. Ethernet switch port 1 - Link/Activity indicator</td>
<td>Flashing (Green)</td>
</tr>
<tr>
<td>C. Ethernet switch port 2 - Link/Activity indicator</td>
<td>Flashing (Green)</td>
</tr>
</tbody>
</table>
D. Ethernet switch port 3 - Link/Activity indicator
Flashing (Green)

Table 3-7: Expansion I/O LED functions

<table>
<thead>
<tr>
<th>Expansion I/O Module LED</th>
<th>Function</th>
<th>LED</th>
</tr>
</thead>
</table>
| TX/RX                    | RX/TX signal (Port B/C for RS485 or RS232 communication) receiving and transmitting data | • Flashing Orange - RX  
• Flashing Green - TX |
| LINK/ACT                 | • Link and Activity indicator for each Ethernet switch port  
• Separate indicator for each Ethernet switch port | Flasing Green when Ethernet activity present |

**Frequency/Digital outputs**

The meter has three user-configurable outputs that can be configured for either a Frequency output or Digital output (FODO).

- FODO1 (eight possible parameter configurations) [Type 2] [Type 4]
- FODO2 (eight possible parameter configurations) [Type 2] [Type 4]
- FODO3 (eight possible parameter configurations) [Type 2] [Type 4]
- FODO4 (eight possible parameter configurations) [Type 4]
- FODO5 (eight possible parameter configurations) [Type 4]
- FODO6 (eight possible parameter configurations) [Type 4]  
  — (DI1Mode must be set to Frequency/Digital Output 6 to enable FODO6)

**Frequency or Digital Outputs (FODO1, FODO6) source options ~ Group 1**

- FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B
- Frequency output 1A is the A Phase of Frequency output 1 content  
  (Uncorrected volume flow rate, Corrected volume flow rate, Average flow velocity, Average speed of sound, Energy flow rate, Mass flow rate)
- Frequency output 1B is the B Phase of Frequency output 1
- Frequency output 2A is based on frequency content (Actual - Uncorrected Flow Rate)
- Frequency output 2B is based on frequency content and Frequency 2B Phase
- Digital output 1A is based on Digital output1A content (Frequency Output 1Validity and Flow Direction)
• Digital output 1B is based on Digital output1B content (Frequency Output 1Validity and Flow Direction)
• Digital output 2A is based on Digital output 2A content (Frequency Output 1Validity and Flow Direction)
• Digital output 2B is based on Digital output 2B content (Frequency Output 1Validity and Flow Direction)

**Frequency or Digital Outputs (FODO2, FODO3, FODO4, FODO5) source options ~ Group 2**

• FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B
• Frequency output 1A is the A Phase of Frequency output 1 content (Uncorrected volume flow rate, Corrected volume flow rate, Average flow velocity, Average speed of sound, Energy flow rate, Mass flow rate)
• Frequency output 1B is the B Phase of Frequency output 1
• Frequency output 2A is the A Phase of Frequency output 2 content (Uncorrected volume flow rate, Corrected volume flow rate, Average flow velocity, Average speed of sound, Energy flow rate, Mass flow rate)
• Frequency output 2B is the B Phase of Frequency output 2 content
• Digital output 1A is based on Digital output1A content (Frequency Output 1Validity and Flow Direction)
• Digital output 1B is based on Digital output1B content (Frequency Output 1Validity and Flow Direction)
• Digital output 2A is based on Digital output 2A content (Frequency Output 1Validity and Flow Direction)
• Digital output 2B is based on Digital output 2B content (Frequency Output 1Validity and Flow Direction)

**Mode options**

• Open Collector (requires external excitation supply voltage and pull-up resistor)
• TTL (internally powered by the meter 0-5 VDC signal)

**Channel B Phase options**

• Lag forward, Lead reverse (Phase B lags Phase A while reporting forward flow, leads Phase A while reporting reverse flow)
• Lead forward, Lag reverse (Phase B leads Phase A while reporting forward flow, lags Phase A while reporting reverse flow)

**Phase A and Phase B output (based on flow direction)**

• Reverse flow - output only reports flow in the reverse direction. For frequency outputs, Phase B of the output is 90 degrees out of phase with Phase A.
• Forward flow - output only reports flow in the forward direction. For frequency outputs, Phase B of the output is 90 degrees out of phase with Phase A.
• Absolute - output reports flow in both directions. For frequency outputs, Phase B of the output is 90 degrees out of phase with Phase A.

• Bidirectional - output reports flow on Phase A only in the forward direction and on Phase B only in the reverse direction.

**Maximum frequency for the frequency outputs**

• 1000 Hz
• 5000 Hz

<table>
<thead>
<tr>
<th>Frequency /Digital output</th>
<th>Source configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency /Digital Output 1</td>
<td>Frequency output 1A</td>
</tr>
<tr>
<td>Frequency /Digital Output 2</td>
<td>Frequency output 1B</td>
</tr>
<tr>
<td>Frequency /Digital Output 3</td>
<td>Digital output 1A</td>
</tr>
<tr>
<td>Frequency /Digital Output 4</td>
<td>Digital output 1B</td>
</tr>
<tr>
<td>Frequency /Digital Output 5</td>
<td>Frequency output 2A</td>
</tr>
<tr>
<td>Frequency /Digital Output 6</td>
<td>Frequency output 2B</td>
</tr>
<tr>
<td></td>
<td>Digital output 2A</td>
</tr>
<tr>
<td></td>
<td>Digital output 2B</td>
</tr>
</tbody>
</table>

Output for FODO1 and Digital Input 1 or FODO6 (Type 4 CPU) (Group 1 on the CPU Module) share a common ground and have 50 V isolation. FODO2, FODO3, FODO4 (Type 4 CPU), and FODO5 (Type 4 CPU) (Group 2 on the CPU Module) share a common ground and have 50 V isolation. This allows an output to be connected to a different flow computer. The outputs are opto-isolated from the CPU Module and have a withstand voltage of at least 500V rms dielectric.
Figure 3-17: CPU Module - Frequency/Digital outputs common ground - Type 2

A. FODO1 and Digital input1 - shared common ground (Group 1)
B. FODO2 and FODO3 - shared common ground (Group 2)

Figure 3-18: CPU Module - Frequency/Digital outputs common ground - Type 4

A. FODO1 and DI1/FODO6 - shared common ground - Type 4 CPU Module (Group 1)
B. FODO2, FODO3, FODO4 and FODO5 - shared common ground - Type 4 CPU Module (Group 2)
Analog input settings

The Rosemount™ 3410 Series Gas Ultrasonic Flow Meter has the capability to sample analog temperature (Analog Input 1) and pressure (Analog Input 2) with 4-20 mA signals. These analog input signals are configured to sink. The two independent analog input circuits are configured for conventional 4-20 mA service. Also, 24 VDC isolated power supply connection is provided for an external power source. Refer to the Field wiring diagram DMC-005324 in 3410 Series engineering drawings.

Analog output settings

The Rosemount™ 3410 Series Ultrasonic Gas Flow Meter provides 4-20 mA analog output signals that are software configurable for either sink or source current (see 3410 Series engineering drawings, DMC-005324).

Full HART® functionality is provided so that any commercially available HART® transmitter which meets the specifications of the HART® Communications Foundation can be connected to the Rosemount Gas Ultrasonic Flow Meter.

- Analog Output 1 (AO1) is user-configurable as a 4-20 mA output and has HART capabilities - Type 2 and Type 4 CPU Modules
- Analog Output 2 (AO2) is user-configurable as a conventional 4-20 mA output - Type 2 CPU Module only

Digital input

The Rosemount™ 3410 Series Gas Ultrasonic Flow Meter provides one digital input that can be used as a general purpose input. The digital input must be configured via the MeterLink Tools|Edit → Compare Configuration screen.

DHCP server switch settings

The meter can be configured to act as a DHCP server. The DHCP server is enabled/disabled via CPU Module DHCP switch as follows:

<table>
<thead>
<tr>
<th>CPU Module switch</th>
<th>DHCP server disabled</th>
<th>DHCP server enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP Switch 2</td>
<td>OFF</td>
<td>ON</td>
</tr>
</tbody>
</table>

Configuration protect switch settings

The meter’s configuration parameters and firmware can be protected against changes via the CPU Module WRITE PROT. switch as follows:
Table 3-9: Configuration protect switch settings

<table>
<thead>
<tr>
<th>CPU Module switch</th>
<th>Configuration protected</th>
<th>Configuration unprotected</th>
</tr>
</thead>
<tbody>
<tr>
<td>WRITE PROT. Switch 3</td>
<td>ON (default setting)</td>
<td>OFF</td>
</tr>
</tbody>
</table>

External power source connection and fuse

Located inside the Transmitter Electronics Enclosure is a connector for a user-provided external power source, a 2 Amp fuse and a 24 V loop power connection for ultrasonic meter analog outputs, temperature transmitter or pressure transmitter devices. The current is limited to 88 mA.

Figure 3-19: CPU Module power source connections

A. Power In connector (main power)
B. 24 V LOOP POWER
C. 2 Amp fuse (used for the main power input)

3.6 Security seal installation

Security seals protect the integrity of the meter metrology and prevent tampering with transducer assemblies. The following sections detail how to properly seal the Rosemount™ 3410 Series Gas Ultrasonic Flow Meter after commissioning. The security seal wires are commercially available.

Be sure to set the WRITE PROT. switch on the CPU Module to the ON position prior to sealing the enclosure.

3.6.1 Seal transmitter electronics enclosure

Use the following instructions to install the security seal wires on the Transmitter Electronics Enclosure.
Figure 3-20: Transmitter electronics enclosure security latch

A. Transmitter Electronics Enclosure end cap. Optional glass endcap for Local Display
B. Security latch

Procedure

1. Rotate the end cap clockwise fully closing and compressing the end cap seal. Install the Security latch using a 3mm Allen wrench.
2. Install the security seal wire into and through one of the two holes in the end cap.
   a) Choose holes that minimize counterclockwise rotation of the end cap when the security wire is taut (maximum wire diameter 0.078 inch; 2.0 mm).
3. Adjust the security wire, removing all slack and thread into the lead seal.
4. Crimp lead seal and cut wire ends to remove excess wire.

### 3.6.2 Base enclosure security seals

Use the following instructions to install the security seal wire on the Base Enclosure.

**Procedure**

1. Install security wire seal into and through the hole in the socket head screw on the Base Enclosure cover (maximum wire diameter .078-in.; 2.0 mm).
2. Position the wire to prevent counterclockwise rotation of the screws when the seal wire is taut.

3. Feed the security wire beneath the Transmitter Electronics Enclosure and through the adjacent socket head screw. Twist the wire, removing all slack and seal.
3.6.3 Transducer assembly security seals

Use the following instructions and Figure 3-24 to install the security seal wire on the transducer assembly.

**Procedure**

1. Rotate the transducer cable nut (Item A) clockwise, compressing the seal on the transducer cable connector.
2. Insert a security seal wire into one of the two holes in the transducer cable connector (Item B) and feed through one of the two holes in the transducer cable nut (Item A).

**Note**

Choose holes that minimize counterclockwise rotation of the transducer cable nut when the security wire (Item C) is taut.

3. Adjust the security wire, removing all slack and thread into the lead seal.
4. Cut wire ends to remove excess wire.
3.7 Sealing the unit

The unit should be properly sealed with a sealing compound after electrical connections have been tested according to the customer's Best Practices schedule. Some areas require a witnessed Acceptance Test for the installed system and require that the meter run for a predetermined length of time (approximately one to two weeks) before the unit is sealed. This allows time to verify all electrical connections are correct, that the meter is accurately measuring flow and that the meter meets the customer's installation requirements. See Startup for systems that use explosion-proof conduit and Startup for systems that use flame-proof cable.
4 Configuration

After the mechanical and electrical installation is complete use the following to install MeterLink™ in order to establish connection with the meter to perform final configuration and verify meter performance.

4.1 Set up the MeterLink™ Procedure

1. Follow the instructions in the MeterLink™ Software for Gas and Liquid Ultrasonic Meters Quick Start Manual (00809-0100-7630) to setup software communications with the meter.
2. Select File → Program Settings and customize the user-preferences (e.g. User name, Company name, display units, Liquid Meter volume units and other interface settings).
3. Connect to your meter. If your meter is not shown in the list, select Edit Meter Directory and setup the connections properties.

4.2 Field Setup Wizard Procedure

1. Use the Field Setup Wizard-Startup in MeterLink™ and select the checkboxes that allow proper configuration for your meter (Temperature, Pressure, Meter Corrections, Meter Outputs, Gas chromatograph setup, Continuous flow analysis and View local display setup). Selections on this page will affect other configuration selections.
   a) Select Next to continue to General setup.
2. Use General setup to configure the meter’s units system (U.S Customary or Metric units) volume units, flow rate time, low flow cutoff, contract hour, enable reverse flow alarm, set meter time and notepad comments.
   a) Select Next to continue to Frequency/Digital Outputs page.

Note
The Meter’s Units system configured on the General Page affect the units for the optional Local Display items.

3. Set the Frequency/Digital Outputs Sources for either a frequency output or a digital status.
   a) Select the Source for each Frequency/Digital output and select the desired drive Mode. The Mode options are Open Collector which requires an external excitation voltage and pull-up resistor or TTL mode which outputs a 0-5 VDC signal.
   b) Select Next to continue to Frequency Outputs page.
4. **Note**
   Frequency outputs 1 and Digital outputs 1 are paired together meaning the Digital outputs 1 will report the status for the parameter for Frequency outputs 1. Similarly, Frequency outputs 2 and Digital outputs 2 are paired together. Additionally, each Frequency output has an A and B output phase.

   Configure Frequency output 1 and Frequency output 2 content, flow direction, Channel B phase, maximum frequency output (Hertz) and full scale volumetric flow rate.

   a) Select **Next** to continue to Meter Digital Outputs.

5. Select the Meter Digital Output parameters for Digital output 1A, Digital output 1B, Digital output 2A and Digital output 2B based on Frequency validity or flow direction.

   If the output of the ultrasonic meter is reversed from what a flow computer is expecting, select **Inverted Operation**. This changes the digital output from a HIGH for a TRUE condition to output a LOW for a TRUE condition.

   a) Select **Next** to continue to Analog Outputs.

6. Configure Analog Outputs.

   Analog outputs can be based on Uncorrected volume flow rate, Corrected volume flow rate, Average flow velocity, Average speed of sound, Energy flow rate or Mass flow rate. The flow direction (Forward, Reverse or Absolute) and Full scale volumetric flow rate used with output (20mA maximum) are also configurable.

   Alarm action parameters determines the state the output will drive during an alarm condition (High 20 mA, Low - 4 mA, Hold last value, Very low - 3.5, Very high 20.5 mA or None).

   a) Select **Next** to continue to the HART® Output(s) parameters.

7. Configure HART® Output parameters, which include four Dynamic process variables (Primary, Secondary, Third and Fourth variable. The Primary variable is set to match the Content set for Analog output 1. If a second analog output is available, the Secondary variable is set to match the Content set for Analog output 2) Identification and HART units (volume units, flow rate time units, velocity units, pressure and temperature units).

   a) Select **Next** to continue to the Meter Corrections page.

8. The Meter Corrections page is used to define parameters for pressure and temperature expansion correction of the meter internal diameter if enabled. Click **Next** to continue to the Temperature and Pressure page.

9. Set the temperature and pressure scaling for analog inputs, enter fixed values, and set alarm limits for both. The alarm limit selections are hold last output value or use fixed value.

   - Live temperature selections include minimum and maximum inputs or fixed temperature.
   - Live pressure selections include minimum and maximum inputs, gage (atmospheric pressure), absolute, or fixed pressure.
a) Click Next to continue to the Gas Chromatograph Setup page.

10. Select the settings below to configure USM device as a Modbus Master to poll a gas chromatograph.

   - **Port**: select which serial port will be connected to the GC. While the port is configured for communications to a GC, it will not act as a Modbus slave device for communications from MeterLink™ or a SCADA system. USM can also poll a gas chromatograph using Modbus TCP/IP. Choose Port as Ethernet.

   - **GC protocol**: select the protocol for which the GC is configured. The Rosemount™ Gas Ultrasonic meter uses 7 data bits, Even parity, and 1 stop bit for ASCII Modbus and 8 data bits, No parity, and 1 stop bit for RTU Modbus. This option will be enabled only when a serial port is selected.

   - **GC baud rate**: select the baud rate for which the GC is configured. This option will be enabled only when a serial port is selected.

   - **GC comms address**: enter the Modbus ID of the GC.

   - **GC IP address**: enter the IP address of the GC. This option is only enabled when Port is selected as Ethernet.

   - **GC TCP/IP port number**: enter Modbus TCP/IP port number of the GC. This option is only enabled when Port is selected as Ethernet.

   - **GC stream number**: enter the stream number for the gas composition the Rosemount™ Gas Ultrasonic meter will read.

   - **GC heating value units**: select the units for which the heating value is configured in the GC.

   - **Use which gas composition on GC alarm**: select which gas composition the Rosemount™ Gas Ultrasonic meter will use if the GC goes into alarm. If Fixed value is selected, the meter will start using the fixed gas composition stored in the meter. If Last good value is selected, the meter will use the last gas composition collected from the GC before the GC started to report alarms.

a) Click Next to continue to the AGA8 page.

11. Configure the properties necessary for the AGA8 calculations.

   This page is only displayed for Rosemount™ Gas Ultrasonic meters if both temperature and pressure are set to Live Analog, Fixed and Base condition correction is selected on the Startup Page. Configuration parameters include:

   - Calculations performed internally (by the meter) or Externally
   - AGA8 method - Gross Method 1, Gross method 2, Detail Method or GERG-2008
   - GC composition source - Fixed, Live GC
   - Base temperature and pressure
   - Specific gravity - reference temperature and pressure
• Volumetric gross heating value and reference temperature
• Molar density reference temperature and pressure
• Flow Mass density, flow compressibility and Base compressibility
• Gas composition inputs - components and mole percent
  
a) Click **Next** to continue to the Continuous Flow Analysis page, if View Continuous Flow Analysis setup was selected on the Startup page.

12. Configure Alarm Limits for flow analysis, reverse flow:
   a) Set low and high flow limits for flow analysis alarms.
   b) Enable/Disable Reverse Flow alarm.
   c) Set Volume limit and low flow limit for reverse flow alarm.
   d) Click **Next** to continue to the **Local Display** setup, if View local display setup was selected on the Startup page.

13. Configure the parameters for the local display.
   a) Use the drop-down arrow in the Display Items list box and select or modify the parameters that will be displayed; the Display items, the Display units and the Scroll Delay.

4.2.1 **Display items**

The Local Display's labels and descriptions are shown below:

<table>
<thead>
<tr>
<th>Table 4-1: Local display labels, descriptions and valid units</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Local display labels, descriptions and valid units</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>QFLOW — Uncorrected volume flow rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• ACF – Actual Cubic Feet</td>
</tr>
<tr>
<td>• ACM – Actual Cubic Meters</td>
</tr>
<tr>
<td>• MACF – Thousand Actual Cubic Feet</td>
</tr>
<tr>
<td>• MACM – Thousand Actual Cubic Meters</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TDYVL — Current day’s forward uncorrected volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>• +ACF – Actual Cubic Feet</td>
</tr>
<tr>
<td>• +ACM – Actual Cubic Meters</td>
</tr>
<tr>
<td>• +MACF – Thousand Actual Cubic Feet</td>
</tr>
<tr>
<td>• +MACM – Thousand Actual Cubic Meters</td>
</tr>
</tbody>
</table>

| TDYVL — Current day’s reverse uncorrected volume |
Table 4-1: Local display labels, descriptions and valid units (continued)

<table>
<thead>
<tr>
<th>Local display labels, descriptions and valid units</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>–ACF</strong> – Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>–ACM</strong> – Actual Cubic Meters</td>
</tr>
<tr>
<td>• <strong>–MACF</strong> – Thousand Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>–MACM</strong> – Thousand Actual Cubic Meters</td>
</tr>
</tbody>
</table>

YSTVL — Previous day’s forward uncorrected volume

<table>
<thead>
<tr>
<th>YSTVL — Previous day’s forward uncorrected volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>+ACF</strong> – Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>+ACM</strong> – Actual Cubic Meters</td>
</tr>
<tr>
<td>• <strong>+MACF</strong> – Thousand Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>+MACM</strong> – Thousand Actual Cubic Meters</td>
</tr>
</tbody>
</table>

YSTVL — Previous day’s reverse uncorrected volume

<table>
<thead>
<tr>
<th>YSTVL — Previous day’s reverse uncorrected volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>–ACF</strong> – Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>–ACM</strong> – Actual Cubic Meters</td>
</tr>
<tr>
<td>• <strong>–MACF</strong> – Thousand Actual Cubic Feet</td>
</tr>
</tbody>
</table>

TOTVL — Forward uncorrected volume

<table>
<thead>
<tr>
<th>TOTVL — Forward uncorrected volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>+ACF</strong> – Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>+ACM</strong> – Actual Cubic Meters</td>
</tr>
<tr>
<td>• <strong>+MACF</strong> – Thousand Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>+MACM</strong> – Thousand Actual Cubic Meters</td>
</tr>
</tbody>
</table>

TOTVL — Reverse uncorrected volume

<table>
<thead>
<tr>
<th>TOTVL — Reverse uncorrected volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>–ACF</strong> – Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>–ACM</strong> – Actual Cubic Meters</td>
</tr>
<tr>
<td>• <strong>–MACF</strong> – Thousand Actual Cubic Feet</td>
</tr>
<tr>
<td>• <strong>–MACM</strong> – Thousand Actual Cubic Meters</td>
</tr>
</tbody>
</table>

QBASE — Corrected volume flow rate

<table>
<thead>
<tr>
<th>QBASE — Corrected volume flow rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>SCF</strong> – Standard Cubic Feet</td>
</tr>
<tr>
<td>• <strong>SCM</strong> – Standard Cubic Meters</td>
</tr>
<tr>
<td>• <strong>MSCF</strong> – Thousand Standard Cubic Feet</td>
</tr>
<tr>
<td>• <strong>MSCM</strong> – Thousand Standard Cubic Meters</td>
</tr>
</tbody>
</table>

TDYVL — Current day’s forward corrected volume

<table>
<thead>
<tr>
<th>TDYVL — Current day’s forward corrected volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>+SCF</strong> – Standard Cubic Feet</td>
</tr>
<tr>
<td>• <strong>+SCM</strong> – Standard Cubic Meters</td>
</tr>
<tr>
<td>• <strong>+MSCF</strong> – Thousand Standard Cubic Feet</td>
</tr>
<tr>
<td>• <strong>+MSCM</strong> – Thousand Standard Cubic Meters</td>
</tr>
<tr>
<td>Local display labels, descriptions and valid units</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>TDYVL</strong> — Current days reverse corrected volume</td>
</tr>
<tr>
<td>• -SCF – Standard Cubic Feet</td>
</tr>
<tr>
<td>• -SCM – Standard Cubic Meters</td>
</tr>
<tr>
<td>• -MSCF – Thousand Standard Cubic Feet</td>
</tr>
<tr>
<td>• -MSCM – Thousand Standard Cubic Meters</td>
</tr>
<tr>
<td><strong>YSTVL</strong> — Previous days forward corrected volume</td>
</tr>
<tr>
<td>• +SCF – Standard Cubic Feet</td>
</tr>
<tr>
<td>• +SCM – Standard Cubic Meters</td>
</tr>
<tr>
<td>• +MSCF – Thousand Standard Cubic Feet</td>
</tr>
<tr>
<td>• +MSCM – Thousand Standard Cubic Meters</td>
</tr>
<tr>
<td><strong>YSTVL</strong> — Previous days reverse corrected volume</td>
</tr>
<tr>
<td>• -SCF – Standard Cubic Feet</td>
</tr>
<tr>
<td>• -SCM – Standard Cubic Meters</td>
</tr>
<tr>
<td>• -MSCF – Thousand Standard Cubic Feet</td>
</tr>
<tr>
<td>• -MSCM – Thousand Standard Cubic Meters</td>
</tr>
<tr>
<td><strong>TOTVL</strong> — Forward corrected volume</td>
</tr>
<tr>
<td>• +SCF – Standard Cubic Feet</td>
</tr>
<tr>
<td>• +SCM – Standard Cubic Meters</td>
</tr>
<tr>
<td>• +MSCF – Thousand Standard Cubic Feet</td>
</tr>
<tr>
<td>• +MSCM – Thousand Standard Cubic Meters</td>
</tr>
<tr>
<td><strong>TOTVL</strong> — Reverse corrected volume</td>
</tr>
<tr>
<td>• -SCF – Standard Cubic Feet</td>
</tr>
<tr>
<td>• -SCM – Standard Cubic Meters</td>
</tr>
<tr>
<td>• -MSCF – Thousand Standard Cubic Feet</td>
</tr>
<tr>
<td>• -MSCM – Thousand Standard Cubic Meters</td>
</tr>
<tr>
<td><strong>VEL</strong> — Average flow velocity</td>
</tr>
<tr>
<td>• Ft/S – Feet per Second</td>
</tr>
<tr>
<td>• M/S – Meters per Second</td>
</tr>
<tr>
<td><strong>SOS</strong> — Average sound velocity</td>
</tr>
<tr>
<td>• Ft/S – Feet per Second</td>
</tr>
<tr>
<td>• M/S – Meters per Second</td>
</tr>
<tr>
<td><strong>TEMP</strong> — Flow-condition temperature</td>
</tr>
</tbody>
</table>

Table 4-1: Local display labels, descriptions and valid units (continued)
### Table 4-1: Local display labels, descriptions and valid units (continued)

<table>
<thead>
<tr>
<th>Local display labels, descriptions and valid units</th>
</tr>
</thead>
<tbody>
<tr>
<td>• DEGF – Degrees Fahrenheit</td>
</tr>
<tr>
<td>• DEGC – Degrees Celsius</td>
</tr>
</tbody>
</table>

PRESS — Flow-condition pressure

<table>
<thead>
<tr>
<th>PRESS — Flow-condition pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>• PSI – Pound per square inch</td>
</tr>
<tr>
<td>• MPA – Megapascals</td>
</tr>
</tbody>
</table>

FRQ1A — Frequency channel 1A

<table>
<thead>
<tr>
<th>FRQ1A — Frequency channel 1A</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HZ – Hertz</td>
</tr>
</tbody>
</table>

FRQ1B — Frequency channel 1B

<table>
<thead>
<tr>
<th>FRQ1B — Frequency channel 1B</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HZ – Hertz</td>
</tr>
</tbody>
</table>

KFCT1 — Frequency 1 K-factor

<table>
<thead>
<tr>
<th>KFCT1 — Frequency 1 K-factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>• CF – Cubic Feet</td>
</tr>
<tr>
<td>• CM – Cubic Meters</td>
</tr>
<tr>
<td>• MCF – Thousand Cubic Feet</td>
</tr>
<tr>
<td>• MCM – Thousand Cubic Meters</td>
</tr>
</tbody>
</table>

FRQ2A — Frequency channel 2A

<table>
<thead>
<tr>
<th>FRQ2A — Frequency channel 2A</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HZ – Hertz</td>
</tr>
</tbody>
</table>

FRQ2B — Frequency channel 2B

<table>
<thead>
<tr>
<th>FRQ2B — Frequency channel 2B</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HZ – Hertz</td>
</tr>
</tbody>
</table>

KFCT2 — Frequency 2 K-factor

<table>
<thead>
<tr>
<th>KFCT2 — Frequency 2 K-factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>• CF – Cubic Feet</td>
</tr>
<tr>
<td>• CM – Cubic Meters</td>
</tr>
<tr>
<td>• MCF – Thousand Cubic Feet</td>
</tr>
<tr>
<td>• MCM – Thousand Cubic Meters</td>
</tr>
</tbody>
</table>

AO1 — Analog Output 1 current

<table>
<thead>
<tr>
<th>AO1 — Analog Output 1 current</th>
</tr>
</thead>
<tbody>
<tr>
<td>• MA – Milliamperes</td>
</tr>
</tbody>
</table>

AO2 — Analog Output 2 current

<table>
<thead>
<tr>
<th>AO2 — Analog Output 2 current</th>
</tr>
</thead>
<tbody>
<tr>
<td>• MA – Milliamperes</td>
</tr>
</tbody>
</table>

**Note**

When connected to a meter with the local display option, reverse flow direction is indicated with a minus sign (negative) before the value(s) shown on the local display.
4.2.2 Display units

The Meter volume units displayed are either U.S. Customary or Metric. To modify the Display Units, configure the Meter units system in the Field Setup Wizard → General Page.

- U.S. Customary volume unit selections are:
  - Cubic feet
  - Thousand cubic feet
- Metric volume unit selections are:
  - Cubic meters
- Display units preceded by a plus or minus sign indicate forward and reverse flow direction.
- The local display Flow rate time units are modifiable by selecting the drop-down arrow and clicking the time unit in the list box.
- Valid flow rate time units selections are:
  - second
  - hour
  - day

4.2.3 Scroll delay

The Scroll Delay is the time interval for the selected display items to be shown on the Local Display. The default scroll delay setting is five seconds. Click the spin box up or down arrow to increase or decrease the length of time an item displays.

Procedure

1. Select Finish to write the configuration settings to the meter.
2. Save the meter configuration file, collect a Maintenance log and Waveforms to document the “As Left” settings.

4.3 Using AMS Device Manager to configure the meter

This procedure assumes you have AMS Device Manager installed on the host computer and have downloaded the latest Rosemount™ Gas Ultrasonic Meter Device Description (DD).

If not installed, click the link below to download the AMS device installation tool kit.

4.3.1 Installing AMS Device description

**Procedure**

1. Use the link above to search for the Device Description (DD) for your Rosemount™ 3410 Series Gas Ultrasonic Flow Meter.
2. Use the Filter Results By categories to narrow-down your search.
   a) Select the check box for HART under Communication Protocol.
   b) Search and select the option Emerson Rosemount™ Industries under the Brand/Manufacturer category.
   c) Select the Gas 3410 Series option under the Device category.
   d) Then, select the desired device revision.
   e) Select AMS Device Manager for the Host System.
   f) Search and select the desired AMS revision under Host System Revision.

---

**Figure 4-1: AMS Device search result**

![Device Install Kits]

- Industries gas 3410 Series Rev 1 HART AMS 10.5 11.0 11.1 11.5
- Delta 10.3 11.3

- Device Install Kit Revision: DD1
- Language: English
- Notes: This device description is installed with AMS Device Manager version 12.0 and higher. You do not need to install it on those versions.

---

3. Click the hyperlink. The file download dialog displays. Click the Save button to save the files to your host system. You may use the default download location or change the directory.
4. Click the **Save** button to complete the file download.

5. Click **Open** or **Open Folder** to view the downloaded files.
6. Establish power to the meter and wiring to Analog Output 1 for HART communication.
7. Start the AMS Device Manager using a laptop or PC.
8. Enter login credentials and click **OK** to launch the application.
9. Click the **Configure** tab, and then select **Guided Setup**, **Manual Setup** or **Alert Setup**.

**Figure 4-4: AMS Device Manager**
4.3.2 AMS Device Manager - Guided setup

The Guided setup wizard provides configuration parameter settings for the meter. The Guided Setup is a subset of the Manual Setup parameters.
Note
Before writing configuration changes to your meter, ensure you have saved the Configuration file and Maintenance log.

Procedure
1. Disable the Write Protect switch in the CPU Module to write any of the following configuration parameters to your meter.

2. Click the Setup Units tab to configure the system units (U.S. Customary or Metric units), Volume units, Flow rate time units, Velocity units, Pressure units and Temperature units.
   a) Click Apply to write the parameters to the meter.

3. Click the Setup Outputs tab to configure the Device Variables Mapping, Units, Frequency/Digital outputs, Frequency and Digital Outputs 1 and 2, Analog outputs, Digital Input, Pressure and Temperature.
   a. Analog output 1 (HART) - Content (Primary Variable) displays Uncorrected Flow Rate and is a read only attribute. Configure Direction (flow), Lower Range value, Upper range value and Alarm Action and view the HART Parameters Tag, Date, Descriptor, Message, Final Assembly Number Poll Address, Number of Response Preambles.
   b. Analog Output 2 - Content (Secondary Variable) displays Uncorrected Flow Rate and has a read only attribute. Configure Direction (flow), Lower Range value, Upper range value and Alarm Action. Map the Third and Four variables using the Manual Setup wizard. Selections include Uncorrected Volume Flow Rate, Pressure and Temperature.

4. Click Apply to write the parameters to the meter after all of the data shown below is entered.
   a) Click the Frequency/Digital Outputs tab to configure Frequency/Digital Output 1, 2 and 3 Source and drive Mode. Select the Source for each Frequency/Digital output and select the desired drive Mode. The Mode options are Open Collector which requires an external excitation voltage and pull-up resistor or TTL mode which outputs a 0-5 VDC signal (each Frequency output has an A and B output phase).

   Note
   If changes are made to any Source variable on this page, apply the changes and navigate to the Guided Setup page. Navigate back to the Manual Setup for the changes to be reflected in other Manual Setup pages.

   b) Click the Frequency and Digital Output 1 tab to configure the Content, (flow) Direction, Channel B Phase frequency output, Lag forward, Lead Reverse or Lead Forward, Lag Reverse (Phase B lags Phase A while reporting forward flow and lead Phase A while reporting reverse flow or the opposite), Digital Output 1 Channel A Content and Polarity, Channel B Content and Polarity, Maximum Frequency, and Lower and Upper Range Units of Measure.
c) Click the **Frequency and Digital Output 2** tab and repeat Step 3b to configure Frequency and Digital Output 2 parameters.

5. Click **Setup HART** to configure the HART parameters (tag, date, descriptor, message text, Final Assembly number, Poll address and number of response preambles are displayed). After all of the data is entered click **Apply** to write the parameters to the meter.

6. Click **Alert Setup** on the Overview page and select the **Flow Analysis** tab and enable Reverse Flow. Click the **OK** button to return to the Overview page.

7. Click the **Service Tools** tab on the Overview page and select the **Variables** tab. The Flow Data, Path Information, Flow Totals, and All Variables data is populated after you are connected to the meter.
   a) Click the **Flow Data** tab and view the Flow Direction (Forward or Reverse), Average Flow and Average Sound Velocities values.
   b) Click the **Path Information** tab and view the Chord performance, Gain, SNR (Signal to Noise Ratio) Signal strength (mV), and Noise (mV).
   c) Click the **Flow Totals** tab to view the volume totals (forward and reverse uncorrected volume).
   d) Click the **All Variables** tab to view a graphical display of the Primary, Secondary, Third and Fourth Variables.

**Figure 4-7: AMS Device Manager - Service Tools All Variables status indicators**

8. Click **OK** to return to the Overview page.

9. Enable the Write Protect switch on the CPU Module to protect the meter's configuration.
10. Click **Display Meter K-Factors** from the Overview window. K-Factors are a read-only values calculated from the Full scale volumetric flow rate used with frequency outputs and the Maximum frequency for frequency output.

![Display Meter K-Factors](image)

11. Click **Next** to return to the Device Manager Overview page.

### 4.3.3 AMS Device Manager - Manual setup

Use the **Manual Setup** wizard to configure the meter’s parameters. See **Figure 4-4** and **Figure 4-5** from the AMS Device Manager Configure menu click **Manual Setup**.
Procedure

1. Remove security wires from the endcap and the Bracket/Cover hex head bolts that secure the Base Enclosure if they are installed.

2. Disable the Write Protect switch in the CPU Module to write any of the following configuration parameters to your meter.

3. Click the **Device Variables Mapping** tab. The Primary and Secondary variables are read only and are configured for Uncorrected Flow Rate. The Third and Fourth variable configuration choices include Pressure and Temperature.

4. Click the **Units** tab (see from AMS Device Manager - Guided setup, Step 2).

5. Click the **Analog Output 1 (HART)** tab (see AMS Device Manager - Guided Setup, Step 3).

6. Click the **Analog Output 2** tab. Follow the configuration instructions in the AMS Device Manager - Guided Setup, Step 3. The read only Secondary variable Content, Uncorrected Flow Rate, displays. Use the drop-down arrow and select the (flow) Direction - Forward or Reverse. Enter a Lower and Upper Range limit. Set the Alarm Action parameters.
   a) Click **Apply**, after you enter the data to write the parameters to the meter.

7. Click the **Frequency/Digital Outputs** tab. Follow the configuration instructions in the Step 4a.
Note
If changes are made to any Source variable on this page, apply the changes and navigate to the Guided Setup page. Navigate back to the Manual Setup for the changes to be reflected in other Manual Setup pages).

a) Click Apply, after you enter the data to write the parameters to the meter.

8. Click the Frequency and Digital Output tab. Follow the configuration instructions in the Step 4b.
   a) Click Apply, after you enter the data to write the parameters to the meter.

9. Click the Frequency and Digital Output tab. Follow the instructions in the Step 4c to configure the Frequency and Digital Output 2 parameters.
   a) Click Apply, after you enter the data to write the parameters to the meter.

10. Click the Temperature tab. Configure the input parameters including: Source (Live Analog or Fixed), Min and Max input limits corresponding to 4 mA and 20 mA respectively and the Low and High alarm limits.
    a) Click Apply, after you enter the data to write the parameters to the meter.

11. Click the Pressure tab. Configure the input parameters including: Source (Live Analog or Fixed), Min and Max input limits corresponding to 4 mA and 20 mA respectively and the Low and High alarm limits. Select either Gage or Absolute for the type of pressure reading desired. If a live pressure transmitter is connected, select the type of reading the transmitter outputs. If Absolute is selected, you must also enter the Atmospheric pressure.
    a) Click Apply, after you enter the data to write the parameters to the meter.

12. Click the Digital Input tab. The default Digital Input 1 polarity is set to Normal for general purpose or set to Inverted when used for calibration.
    a) Click Apply, after you choose the calibration data to write the parameters to the meter.

- Calibration Polarity configuration parameter selections are:
  — Digital Input 1 Calibrate Active High
  — Digital Input 1 Calibrate Active Low

- Calibration Gating configuration parameter selections are:
  — Edge gated, active high
**Figure 4-10: Gating configuration parameter Edge gated, active high**

- High
- Low

---

- Edge gated, active low

**Figure 4-11: Gating configuration parameter Edge gated, active low**

- High
- Low

---

- State gated, active high

**Figure 4-12: Gating configuration parameter State gated, active high**

- High
- Low

---

- State gated, active low
13. Click the **Alert Setup** tab (from the main Configuration page).

**Figure 4-14: Configure Flow Analysis Alert**

14. Click the **Flow Analysis** tab to select Configure Reverse Flow Detection, if desired. The default setting is **Disabled**. Click the **Disabled** button to send the feature command to the meter. Check for a response error. Click the **Enable** button if no error response is received.

   a) Enter the minimum reverse flow velocity above which to accumulate flow in the reverse direction for this alert. Enter a positive value for the Reverse Flow Zero Cutoff. Click the **Next** button to write the values to the meter. Check for an error response. If no error response is received, click the **Next** button. The Detect Reverse Flow enabled page displays. Click the **Next** button to display Detect Reverse Flow disabled.

   b) Click the **Next** button to display the Method Complete page if an error message is returned.
c) Click the **Set Flow Range Limits** button and enter a positive value for the Flow Analysis Lower Velocity Range and the Upper Velocity Range Limits. When the velocity is outside of the limit parameters, an alert is triggered. Click the **Next** button to display the Method Complete page.

15. Click the **Service Tools** tab to access the device alerts, variables, trends and maintenance statuses or to edit the configuration parameters.

a) Click the **Service Tools | Alerts** tab. If an alert condition exists, the alert type and description displays. Recommended actions are listed to assist you in a resolution. After you resolve the alert condition, click the **Acknowledge** button to clear the alert. Click **Apply** to write the changes to the meter. If no alert condition is active, click **OK** to close the device window.

---

**Figure 4-15: AMS Device Manager - Service Tools Alerts**

b) If you change the device configuration, a confirmation dialog displays and prompts you to write the changes to the meter. Click **Yes** to write the changes to the meter or click **No** to cancel pending changes.
c) Click the **Service Tools → Variables** tab. The Variables page displays tabs for the device's Flow Data, Path Information, Flow Totals, and All Variables.

The **Service Tools → Flow Data** page includes charts for flow and sound velocities. The flow values (flow direction, average flow velocity and average sound velocity) parameters are displayed for the connected device.
d) Click **Service Tools → Variables → Path Information** tab to view the device's chord performance (%), Gain (dB), SNR (dB), Signal (mV) and Noise (mV).

e) Click **Service Tools → Variables → Flow Totals** to view the volume totals (forward and reverse Uncorrected Volume) parameters for the connected device.

f) Click **Service Tools → Variables → All Variables** tab to view Primary, Secondary, Third and Fourth Variable parameter status.

**Figure 4-18: AMS Device Manager - Service Tools All Variables**

Gauges display each variable's status as good or bad. If a status is bad refer to the Service Tools Alerts page for recommended actions to resolve the alert condition. Also refer to the Field Device Specification manual (00825-0400-3240) for Commands 48 and 140 details.

**Important**

Alerts are triggered for Command 48 Additional device status and Command 140 detailed status information. Alerts are grouped as Failed - Fix Now, Maintenance - Fix Soon and Advisory according to the severity level; 1-6. Severity 1 is the highest and 6 is the lowest level.

g) Click the **Service Tools → Trends** tab to display the device variables (uncorrected volume flow rate, pressure and temperature) trends.
Primary and Secondary variables display real-time uncorrected volume flow rate trends. The third and fourth variables charts displays trends for temperature and pressure.

16. Click the Service Tools → Routine Maintenance tab. Click Analog Output 1 Trim to perform a digital to analog trim adjustment of the first milliampere output. The 4mA and 20mA output current values should equal the plant's standard values. Click Yes to confirm the configuration changes. Repeat this step to trim Analog Output 2 current. Click Apply to write the output trim values to the meter. Click OK to navigate back to the Service Tools page.

After you have changed and written the configuration changes to the meter do the following:

a) Enable the Write Protect switch on the CPU Module to protect the meter's configuration.

b) Replace the end cap and if required, apply security seals through the endcap holes and through the hex head bolts that secure the Bracket/Cover to the Base enclosure.

Note
The next time you connect to the device using MeterLink, the Monitor page displays a Meter status alarm that the configuration has changed and remains latched until acknowledged. Click the Ack (acknowledge) button to clear the alarm.
4.4 Using a Field Communicator to configure the meter

Prerequisites

- Rosemount™ HART Device Description (HART DD) installed for the meter
- Network configured for a Field Communicator
- System wiring diagram drawing number DMC-005324 (see Engineering drawings)
- Power supply

Procedure

1. Remove electrical power to the meter. If installed, remove the endcap security latches and seals and then, remove the endcap.
2. Refer to the Field Communicator Users Manual wiring diagrams and commissioning instructions provided with your handheld device. Register the product to activate the end user license.
3. Fully charge the Field Communicator battery prior to use.

**Important**
Do not change the battery in a hazardous area environment. The power supply is not intrinsically safe.

Wire Analog Output 1 (AO1) as shown in Engineering drawings, drawing DMC-005324.

4. On the meter, run the wires through the field wiring conduit and into the transmitter electronics enclosure.
A. Field wiring conduit entries (4)

5. Wire Analog Input 1 (AI1) and Analog Output 1 (AO1) as shown in Figure 4-21 and Engineering drawings, drawing DMC-005324.

6. Use the leads provided with the Field Communicator to connect to your device.

7. Press and hold the **Power** button on the Field Communicator until the green light blinks.

8. Use the touch screen on the Field Communicator, the keypad or use the stylus to navigate through the device menus.

9. Refer to the Menu tree in Section D.1.1 of the Rosemount™ HART Field Device Specification manual (00825-0400-3240) for the device fast key sequences. Included in the menu tree are:
• Diagram Page 1 - 3410 Series Root Menu; **Overview, Configure** → **Manual Setup**

• Diagram Page 2 - **Configure** → **Manual Setup** (continued) and **Alerts Setup**

• Diagram Page 3 - **Service Tools** → **Alerts** and **Variables**

• Diagram Page 4 - **Service Tools** → **Variables** (continued), **Service Tools** → **Trends**, and **Service Tools** → **Maintenance**

10. If you encounter problems, refer to the contact information on the back cover of this manual or the contacts included in the Field Communicator User's Manual.

### 4.5 Security seals for the meter (optional)

For the integrity of the meter metrology and to prevent tampering with the transmitter electronics and transducer assemblies, attach security latches on the end caps and install security wires, if required, on the Transmitter Electronics Enclosure end caps, the Bracket/Cover cap head screws. See Security seal installation and Sealing the unit. Seal the conduit ports with sealing compound according to the customer's requirements (e.g., after approximately one to two weeks of run time). Also, see Startup for systems that use explosion-proof conduit.

### 4.6 Configure users and network security

Starting with Rosemount 3410 Series Firmware v1.60, the meter must authenticate any user making a connection to the meter using MeterLink. MeterLink will prompt for a username and password that will be authenticated by the meter before a successful connection is established. While the default password is unique to each meter, it is highly recommended to be changed at meter startup. For added security, the default username, administrator, can be changed as well. See Manage Users in the Rosemount 3410 Series Gas Ultrasonic Flow Meters: Operations Manual (00809-1100-3104) for more details on setting up users, user types and passwords using the Meter → Manage Users dialog box in MeterLink.

If the Rosemount 3410 Series Electronics will be connected to a network, please read the security recommendations found in Cybersecurity and network communications in the Rosemount 3410 Series Gas Ultrasonic Flow Meters: Operations Manual (00809-1100-3104).
A  Engineering drawings

A.1  3410 Series engineering drawings

This appendix contains the following engineering drawing(s) for the ultrasonic meter:

| DMC-005324 | Rosemount™ 3410 Series Ultrasonic Gas Flow Meter System Wiring Diagram |
B  Open source licenses

B.1 List of source codes for executable files
For a copy of the source code covered under the open source licenses indicated in
this appendix, please contact flow.support@emerson.com.

B.2 GNU General Public License
For more details about GNU GPL (General Public License), follow the link below:
www.gnu.org
Micro Motion Inc., uses GPL version 2.
www.gnu.org/licenses/old-licenses/gpl-2.0.html
The GNU GPL is currently version 3
www.gnu.org/licenses/quick-guide-gplv3.html
For older versions of the GNU General Public License, follow the link below:
www.gnu.org/licenses/old-licenses/old-licenses.html#GPL
See GPL license on the following pages.

The GNU General Public License (GPL)
Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble
The licenses for most software are designed to take away your freedom to share
and change it. By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users. This General Public License applies to most of the
Free Software Foundation's software and to any other program whose authors
commit to using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish), that you
receive source code or can get it if you want it, that you can change the software
or use pieces of it in new free programs; and that you know you can do these
things.
To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

**TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION**

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to any such program or work, and a “work based on the Program” means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included without limitation in the term "modification"). Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for noncommercial
distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and "any later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use
to the public, the best way to achieve this is to make it free software which
everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to
the start of each source file to most effectively convey the exclusion of warranty;
and each file should have at least the "copyright" line and a pointer to where the
full notice is found.

One line to give the program's name and a brief idea of what it does. Copyright
(C) <year> <name of author>

This program is free software; you can redistribute it and/or modify it under the
terms of the GNU General Public License as published by the Free Software
Foundation; either version 2 of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU General Public License for more
details.

You should have received a copy of the GNU General Public License along with
this program; if not, write to the Free Software Foundation, Inc., 59 Temple Place,
Suite 330, Boston, MA 02111-1307 USA

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts
in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
with ABSOLUTELY NO WARRANTY; for details type `show w'. This is free software,
and you are welcome to redistribute it under certain conditions; type `show c' for
details.

The hypothetical commands `show w' and `show c' should show the appropriate
parts of the General Public License. Of course, the commands you use may be
called something other than `show w' and `show c'; they could even be mouse-
clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary. Here is a
sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program
`Gnomovision' (which makes passes at compilers) written by James Hacker.

signature of Ty Coon, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the GNU Library General Public License instead of this License.

B.3 GNU Lesser General Public License

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007


Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.
If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

"a) under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still operates, and performs whatever part of its purpose remains meaningful, or

"b) under the GNU GPL, with none of the additional permissions of this License applicable to that copy.


The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.


You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a) Give prominent notice with each copy of the Combined Work that the Library is used in it

and that the Library and its use are covered by this License.

b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

c) For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL and this license document.

d) Do one of the following:

0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on the user’s computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the Linked Version.
e) Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries
You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the terms of this License.

b) Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License
The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy’s public statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

B.4 BSD Open Source License
For more details about the Open Source™ BSD license or the Open Source Initiative, follow the link below:

www.opensource.org/licenses/bsd-license.php

Copyright (c) <YEAR>, <OWNER>
All rights reserved.
• Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
  — Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
  — Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
  — Neither the name of Rosemount™ nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.5 M.I.T License

For more details about the Open Source™ MIT license or the Open Source Initiative follow the link below:

www.opensource.org/licenses/mit-license.php

The MIT License

Copyright (c) <year> <copyright holders>

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
B.6 **Zlib License**

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.